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Thank you for purchasing FUJIFILM Science Lab 2001 Image Gauge. Before
using this software, please be aware of the following important items.

Regarding the use of Science Lab 2001 Image Gauge software:
When you first started using this software, you agreed to the usage conditions
specified below, and Fuji Photo Film Co., Ltd. granted you a license to use the
Science Lab 2001 Image Gauge software.
The ownership rights to the software belong to Fuji Photo Film Co., Ltd. and
Kohshin Graphics Systems Inc. In keeping, this software is not something that
is sold to you but something that Fuji Photo Film Co., Ltd. grants you a license
to use. The recording media is yours, but the ownership rights to the software
remain with Fuji Photo Film Co., Ltd.

LICENSE TERMS
1) You are granted the use of Science Lab 2001 Image Gauge software

for a single CPU or a single unit within multiple CPUs. Hence, in a
computer network environment, a separate Science Lab 2001 Image
Gauge software license will be required for each unit that will be using
the software.

2) You are allowed to copy Science Lab 2001 Image Gauge software onto
different media for backup and program execution purposes.

USAGE LIMITATION
1) No copying, modification or transfer of Science Lab 2001 Image Gauge

software other than specified by the terms of the usage license is
allowed.

2) No reverse compiling or reverse assembling of Science Lab 2001
Image Gauge software done for the purpose of turning Science Lab
2001 Image Gauge software into a readable format is allowed.

3) No lending or distribution of Science Lab 2001 Image Gauge software
or a part thereof for profit is allowed.

4) No derivative copyrighted product can be produced from Science Lab
2001 Image Gauge software, or modifications of it, or in conjunction
with other software.

NOTES
1) Reproduction of parts or all of the contents of this manual without

permission is prohibited.
2) The contents of this manual are subject to change without notice.
3) This manual has been prepared with utmost care. However, if you have

any questions or find errors, omissions, etc., please contact us.
4) We will not be liable for any effects incurred from the use of this device.

Copyright Reserved

<Reprint and/or reproduction of parts or whole of this manual is prohibited.>

Copyright© 1998-1999 by Fuji Photo Film Co., Ltd.

Apple logo is a registered trademark of Apple Computer, Inc. CanvasTM is a registered
trademark of Deneba Co., Ltd.  Excel is a registered trademark of Microsoft Co., Ltd.
Macintosh, Quick Time, and Geneva are registered trademarks of Apple Computer, Inc.
Adobe Photoshop is a registered trademark of Adobe Systems Co., Ltd. in the U.S.
All other company names and product names mentioned here in are the trademarks or
registered trademarks of their respective owners.

Read this first:
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1 "Portions of this product are copyright ©1991-1997 Altura Software Inc.
All rights reserved."

2 "COMPANY'S LICENSOR (S)  MAKES NO WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, REGARDING THE SOFTWARE.
COMPANY'S LICENSOR (S)  DOES NOT WARRANT, GUARANTY,
OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE
RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS
CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR
OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND
PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. THE
EXCLUSION OF THE IMPLIED WARRANTIES IS NOT PERMITTED
BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO
YOU."

3 "IN NO EVENT WILL COMPANY'S LICENSOR (S), AND THEIR
DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS
(COLLECTIVELY "COMPANY'S LICENSOR")  BE LIABLE TO YOU
FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION,
AND THE LIKE)  ARISING OUT OF THE USE OF, OR INABILITY TO
USE , THE SOFTWARE EVEN IF COMPANY'S LICENSOR HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION
OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES,
THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU."
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This equipment cannot be taken to or used in a country
or area where power supply specifications differ from
those in the country or area where it was originally
installed.

This device is in compliance with the VCCI standards established by the conference on self-imposed control of noise
interference caused by information devices for the purpose of preventing interference in commercial and industrial
areas caused by Class 1 information devices (information devices to be used in commercial and industrial areas).
If this device is used in residential areas adjacent to them, it may cause radio disturbance.
This device must be handled correctly in accordance with this operation manual.

JAPAN

This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance
with the instructions manual, may cause interference to radio communications.
It has been tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of part
15 of FCC Rules, which are designed to provide reasonable protection against such interference when operated
in a commercial environment.
Operation of this equipment in a residential area is likely to cause interference in which case the user at his own
expense will be required to take whatever measures may be required to correct the interference.

United States of America

This digital apparatus does not exceed the Class A limits for radio noise emission from digital apparatus as set out
in the radio interference regulations of the Canadian Department of Communications.

“Le présent appareil numérique n’émet pas de brults radioélectriques cépassant les limites applicable aux appareils
numériques de la class A prescrites dans le Réglement sur le broulilage radioélectrique édicté par le ministére des
Communications du Canada.”

Canada
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1. Image Gauge Ver. 4.0

1.  Image Gauge Ver. 4.0

1 Image Gauge Ver. 4.0 (hereinafter referred to as "this software,") is
for analyzing and quantifying the image data input from the Image
Reader originally introduced to the market by Fuji Photo Film Co., Ltd.
and for image analysis and quantification of image data in RAW, PICT
and TIFF format.

2 The sample screens throughout this manual match the functions
described and the assumed selections and items that appear. In
keeping, when reading the manual.

3 For details on image reading through the IP Reader (BAS series and
FDL-5000), IP/Fluorescent Reader (FLA-2000 / 2000G, FLA-3000 /
3000GÅAFLA-5000ÅAFLA-8000) or Chemiluminescent/Fluorescent
detecting camera  (LAS-1000 / LAS-1000plus / LAS-1000mini), refer
to each operation manual.

4 Image files created with versions earlier than this software (MacBAS
V2.0 Å` V3.0, Image Gauge V.3.01 Å` V3.4) can be opened, analyzed and
subjected to other operations using this software. Image files created
with this software, however, cannot be used with previous versions
(upwardly compatible).

5 Use of this software has been confirmed for the following combinations
of systems connected to the IP Reader. If other combinations are used,
the software may become inoperable, depending on the SCSI.

Macintosh: PowerMac G4 733
Blue G3, G4, G3 MT266/ZIP, MT300/ZIP
* This software cannot be used on the 68K machine.

OS: Mac OS 9.21
SCSI card: 2906 (Adaptec)
CRT: 832x624 or more, 256 color or more

(we recommend the 32,000 color or more.)
LBP: LBP 350 (Canon)
Peripheral devices: Pictrography 3000(32MB/48MB), 3500,4000(120MB),

PSD400(96MB)
Application memory: Will differ depending on the image file size handled.

This manual has been written based on the assumption that the user
has experience using the Macintosh and is familiar with its basic opera-
tion and displays.

(Image file size + 10~20MB)

Reader Application Memory

BAS-5000 190MB or more

FLA-3000/3000G 95MB or more

BAS-2500
FLA-2000 90MB or more

FLA-2000G

BAS-1800II 75MB or more

BAS-1800 70MB or more

BAS-1500 36MB or more

BAS-1000 25MB or more

FDL-5000 45MB or more
LAS-1000 25MB or more

LAS-1000plus
FLA-5000 582MB or more
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2. System Configuration <Supporting Peripheral Devices> (underlined units: available for old users)

IPR: BAS-5000, BAS-2500, BAS-1800, BAS-
1800II, BAS-1500, BAS-1000, FLA-3000/
3000G,
FLA-2000/2000G, LAS-1000/1000plus,
FDL-5000, FLA-5000 (Either one)

Image buffer: IB-200

Pictro: Pictrography 3000 (32MB/48MB),
Pictrography 3500 ,
Pictrography 4000 (120MB), PSD-400
(Either one)

LBP: LBP320 Pro (Canon), LBP750 (Canon),
LBP350 (Canon),
Laser Jet 6L(HP), Laser Jet 4LJ Pro(HP),
Laser Writer Select 610(Apple)
(Either one)
* 2MB memory should be expanded for the Canon's LBP and

HP's LBP.

2. System Configuration
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1 Insert the CD-ROM labeled Science Lab into the DC-ROM drive.

2 Drag and copy the Science lab folder in the CD-ROM onto the
Macintosh hard disk.

3 Place the 2 function extension files included in the <To Function Exten-
sion> folder in the system folder.

4 The software can be used.

5 Installation of Image Gauge Ver. 3.4 is now completed.

After installation, the following dialog box appears at the initial start of
Image Gauge Ver.4.0.

Type your name and department, and then click the            button.

Image Gauge Ver.4.0 starts up.

3. Installing Image Gauge
Ver. 4.0

3.  Installing Image Gauge Ver. 4.0
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1 Using the control panel memory settings, set virtual memory and RAM
disks to OFF. If they are used, operations may become unstable and
system errors may result.

2 Using the control panel monitor settings, select the 256 color or more
option.

3 Depending on the balance between the image size and the memory
capacity used by the application, an error can result or image cannot be
printed when command for image printing is issued to the LBP. Take
appropriate countermeasures as follows.
* When "Memory insufficient" error display appears:

Select one of the following 3 alternatives accordingly.
(1) Set output resolution mode to "Auto" for Print Option settings.

The software will automatically select "Auto" mode.
(2) Increase application memory capacity and then issue the com-

mand for printing again.
(3) Reduce the target area for printing by trimming it.

Target sizes will differ slightly depending on the printer type or how
the image data is complicated.

*When an image cannot be printed:
It is possible that memory capacity allocated to the printer driver is not
sufficient or memory installed in the printer is not enough. Decide
appropriate memory size by referring to the User Manual that comes
with the printer.

4 Image files saved with this software version cannot be opened with
software versions earlier than Image Gauge Ver. 3.2.

5 After the fitting operation using the calibration line, the result of image
processing that was printed to the HP LaserJet 6L with 600dpi in 100%
size can be incorrect (negative portion reversed to the positive portion
around the Y axis). Such incorrect printing can be avoided by setting
300dpi and 90% instead.

6 To analyze an image, memory capacity same as the size of the target
image must be available in the media in which the image exists (HD/
MO). Image saving, rotation or flipping is possible only when sufficient
capacity is available.

4. Image Gauge Ver. 4.0
Operating Environment

Image size Application size

BAS-1000 2MB 25MB Full print possible when set to "Better"

BAS-1500 16MB 36MB Full print possible when set to "Better"

BAS-2500 64MB 90MB Full print possible when set to "Good"

BAS-5000 160MB 190MB Full print possible when set to "Good"

* Rough targets:
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Viewing an Image
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1. Starting Up and
Quitting this Software

Starting Up

1.  Starting Up and Quitting this Software

1 Double-click the  icon.

A few seconds after the opening dialog appears, the application will start
up.

4.0
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Quitting

Quit  Q

1 Select Quit from the File menu.

1.  Starting Up and Quitting this Software

When Image Gauge file format has been specified, the quitting proce-
dure will continue as follows.

2 The following dialog will be displayed asking whether or not you want to
save the image data analyzed using Image Gauge.

3 To save the analyzed data (quantification area data, measurement
results, etc.), click YES.
Click NO if you don't want to save the quantification results.

Note:  Analysis data will be added to the Image Gauge image file. File size will
increase or decrease according to the volume of the data. Therefore, always pay
attention to the data storage capacity of the media.
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2. Image Gauge Menu
Lists

The following six main menus are displayed on the Image Gauge menu
line.

2.  Image Gauge Menu Lists

Simple explanations of the command groups (pulldown menus) for each
main menu follow.
Only the commands unique to Image Gauge, and not those for the
Macintosh system in general, will be explained.

Note:  The command key (     ) and letter displayed to the right of each command
are shortcut keys. Holding down the command key on the keyboard and inputting
the appropriate letter will produce the same result as making a selection from the
pulldown menu.

File menu

Opens an image file

Opens an image file after trimming it

Closes the window

Opens the original image file

Shows file information

• • • (1)

• • • (2)

• • • (3)

Sets display observing conditions

Changes the unit of distance

Changes the unit of quantification

Imports RAW file

Imports PICT file

Imports ROI/Lane data

Saves file in PICT format
Saves file in TIFF format
Saves file in RAW format
Saves file in TEXT format
Saves ROI data

Makes Fuji's standard
format

(1)

(2)

(3)

Prints to laser beam printer

Prints to Pictrography

• • • (4)

(4) Screendumps to laser beam printer

Screendumps to Pictrography
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Edit menu

2.  Image Gauge Menu Lists

Makes a duplicate

Forms measured results into a group

Undoes Group

Image menu

Pastes image on the Clipboard

Returns to the default magnification

• • • (1)

• • • (2)

Enhances contrast by compressing the range

Changes the order of colors on the color bar

Monitor display will be negative gray

Monitor display will be positive gray

Monitor display will be in 16 pseudo-colors

Monitor display will be in 32 pseudo-colors

Monitor display will be in a green fluorescent color

Monitor display will be in a red fluorescent color

Monitor display will be in a blue fluorescent color

(1)

(2)

Adjusts contrast via linear tone curve

Adjusts contrast via S tone curve

Adjusts contrast via exponential tone curve

Adjusts contrast via curved tone curve

Adjusts contrast via period tone curve

Adjusts contrast via free-hand tone curve
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The items in the Analysis menu will differ depending on the window that is
active at the time.

When Profile Window is active

(1)

(2)

(3)

Creates new calibration curve

Displays current calibration curve

Analysis menu

When Image Window is active

When Result Window is active

Sets lane to the standard molecular measurement lane

Clears the current standard lane setting

Sets the number of pixels for Auto Trace

Sets lane width

Automatically searches for peak pixel

Automatically searches for lane

Renumbers data in order

--- (1)

--- (2)

Searches for peak

--- (3)

(4)

(5)

(6)

Creates new calibration curve

Displays current calibration curve

Clears background

Sets background within group

Sets background for all areas

Sets the display for targeted values and
numbers
Sets items to be displayed

--- (4)
Displays detailed on measured numbers

--- (5)

Sets a standard of 100%
Inputs absolute distance from distance measure-
ment

--- (6)

Renumbers data in order

Sorts measurement Nos.

(7) Sets profile display
Sets parameters for automatic
  recognition of profile backgrounds
Sets parameters for automatic
  recognition of lanes

Renumbers data in order

Displays details for measurement Nos.

Searches for peak

Creates backgrounds

Copies profile background line for use with other profiles

Clears profile background line

Copies profile RF value for use with other profiles

--- (7)
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Windows menu

Applications menu

Enters other applications

2.  Image Gauge Menu Lists

Displays image

Displays whole image

Displays profile

Displays Info window

Displays Quant mode measurement results

Displays Profile/MW mode measurement results

Displays Distance mode measurement results
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3. Viewing an Image

3.1 Image Reading See "Image Reader" operation manual for detialed oeprations.

3.2 Opening an Image
File

Open...  O

1 Select Open... from the File menu to display the image file dialog.

Note:  With Image Gauge, only one image file can be opened at one time. If some
image file has been altered, the following dialog will be displayed. Select YES or
NO.
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2 Double-click the file name you want to open in the preview window.

Displays the small preview image.

Click when you want to display the image preview.

When the desired file cannot be found in the current folder, use the drop-
down menu arrow to display other folders or files.

3.2  Opening an Image File

Drop-down menu arrow

Note: The image read by the Image Reader can be opened with the Open...
command.  However, in this case, the Trimming dialog will be displayed. (See next
page, 3.3 Trimming an Image, for details.)
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3.3 Trimming an Image

Trim Again...

1 Select Trim Again... from the File menu to display the image file dialog.

3.3  Trimming an Image

2 Open the desired file.
(If the desired file cannot be found in the current folder, use the drop-
down menu arrow and display other folders or files.)

3 After a file has been selected, the following Trimming dialog will appear.
Referring to the table on the following page, set the region of interest
(for trimming).

Trimming box

Range Scope (see p. B-27, 5.3 Enhancing Contrast with Range Scope.)
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Operation MethodShape of Pointer

Resizing

When the mouse pointer is placed on the
frame or a corner of the trimming box, its
shape will change as shown on the left,
allowing it to be dragged.

When the mouse pointer is brought inside
the trimming box, its shape will change to

, allowing it to be dragged.

3.3  Trimming an Image

Purpose

When you bring the mouse pointer back
outside the trimming box (the pointer will
change to a  ), click the mouse. The
trimming box will disappear, and settings
can be redone with dragging.

Moving

Resetting

4 If you click the  to select it, the following display will be
displayed. You can set the width/height of trimming frame (pixels) and
the range of the Range Scope by inputting each value directly.



B - 12

2001. Dec.   Version 1.0

5 For trimming only, when there's no need for rotated/flipped display, click
OK. (To display an image after rotating/flipping it, proceed to the next
page.)

Note: When sufficient application memory capacity has not been alloted, the OK
button may not be activated, as illustrated below.  In such a case, add memory or
reduce the trimming area to activate the OK button and then click it.

3.3  Trimming an Image
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6 To display an image after rotating/flipping it, click Rotate/Flip... in the
Trimming dialog and set rotation/flipping conditions in the Rotate/Flip
dialog that will appear.

3.3  Trimming an Image

Flips the image along
the vertical axis

Flips the image along
the horizontal axis

After completing
settings, click this
button.

90o clockwise rotation

180o rotation

90o counterclockwise rotation

7 After completing trimming and rotation/flipping settings, click OK in the
Trimming dialog.

Flips the image along
the horizontal axis after
rotating 90o clockwise

Flips the image along
the horizontal axis after
rotating 90o counter-
clockwise



B - 14

2001. Dec.   Version 1.03.4  Dividing and Saving an Image

3.4 Dividing and
Saving an Image

1 To divide the image currently displayed in the Trimming dialog into
several files, click Save as... after specifying trimming options.
Only the image will be divided. ROI and other additional information will
not be saved.

3 When the image file has been created, the original Trimming dialog will
be displayed.

2 Input the file name, specify where it should be saved and click OK.
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4. Names of the Parts of the Image Gauge Window

4.  Names of the Parts of the Image Gauge Window

Scroll box

Zoom box

Title bar

Image area
Scroll box Size box

Magnifica-
tion ratio

Tool box
scroll arrow

Scroll arrow

Close box

Mode selector

Tool box
(Changes with

 each mode)

Unit
Menu line

Selected mode
(here, Annotation)

Selected
tone curve Image size

Size of
pixels
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5. Changing the Monitor
Display

5.1 Changing the Display
Color

Color Type

5.1  Changing the Display Color

Negative Gray Negative gray display (low density regions are white, high density regions

are black).

Positive Gray Positive gray display (low density regions are black, high density regions are

white).

16 Color Displays in 16 pseudo-colors.

32 Color Displays in 32 pseudo-colors. (Designation of colors for high and low

density regions is done with Brightness/Contrast.)

Green Displays in a green fluorescent color

Red Displays in a red fluorescent color

Blue Displays in a blue fluorescent color

1 Select Color Type from the Image menu and then select the desired
monitor display command from the submenu.

5.2 Adjusting Contrast

Brightness/Contrast...

1 Select Brightness/Contrast... from the Image menu and then select the
desired contrast adjustment (tone curve) command from the submenu.

Linear... Adjusts contrast with a linear curve (see 3 on p. B-18).

Sigmoid... Adjusts contrast with an S tone curve (see 4 on p. B-19).

Exponential.. Adjusts contrast with an exponential tone curve (see 5 on p. B-21).

Curve... Adjusts contrast with a tone curve (see 6 on p. B-23).

Triangular... Adjusts contrast with a period tone curve (see 7 on p. B-25).

Free Hand... Adjusts contrast with a free-hand tone curve (see 8 on p. B-26).
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2 A Change Curve Dialog like the one below will be displayed. (When
monitor display will be in color, you can use Color:  to select 16 or
32 colors for black and white in low density regions.

5.2  Adjusting Contrast

16

Density distribution on
an image is displayed.

Save... Saves the set 5 kinds of tone curves as a file.

Load... Calls up the tone curves saved as a file. When this file is called up on

another image, these tone curves can be applied to it.

Edit Values... Used when directly inputting values for density band of gradation and/or its

top/bottom values.

To change the contrast adjustment command, make selections from the
pulldown menu for Kind:  .Linear
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3 Linear
3-1 Drag the adjuster (  ) inside the gradation bar until contrast is

appropriate. Image contrast will change in realtime in keeping with
the dragging.

5.2  Adjusting Contrast

Another method for adjusting image contrast is to drag each dial
on Bright: and Cont: with the mouse.

Or, click the  to select it, the following dialog will be dis-
played.  Input the desired values directly.

Adjuster

Restores adjuster
to its initial status.

3-2 After contrast has been adjusted, click OK.
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4 Sigmoid
4-1 Drag Cont: dial to adjust S tone. (Sigmoid coefficient will be

changed.)

4-2 By dragging the adjusters on the left and right, you can change the
contrast band.

5.2  Adjusting Contrast
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4-3 Drag the limitation adjustor located on upper and lower to change
the density band.

4-4 Or, click the  to select it, the following dialog wil be dis-
played. Input the desired values directly.
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5 Exponential
5-1 Drag Curve: dial to adjust curvature of the exponential curve.

(Values of the curvature parameter will be changed.)

5-2 By dragging the upper limit bar, you can slide the exponential curve
without changing the curvature.

Curvature
parameter

Exponential
curve

Upper limit
bar
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5-4 After adjusting the contrast, click OK.

5-3 Or, click the  to select it, the following dialog will be
displayed. Input the desired values directly.
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6 Curve
6-1 Change the tone curve by dragging the mouse.

Tone curve

5.2  Adjusting Contrast

6-2 By dragging the curve adjusters on the left and right, you can
change the contrast band.

Curve
adjuster
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When the tone curve is dragged with the option key pressed, it will
change to a  Sigmoid curve.

6-4 After adjusting the contrast, click OK.

6-3 Or, click the  to select it, the following dialog will be
displayed. Input the desired values directly.
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7 Triangular
7-1 You can move the periodic-change gradation bar by dragging it.

5.2  Adjusting Contrast

7-3 After adjusting the contrast, click OK.

7-2 When you drag the Bright: dials (  )with the mouse, you
can adjust the period.
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8 Free Hand
8-1 By dragging the mouse in Free Hand, you can make a free-hand

line (tone curve).

5.2  Adjusting Contrast

8-2 After adjusting the contrast, click OK.

Import Function
When Import... is clicked with Free Hand selected, tone curve data will be read from the
TEXT file and setting will be possible using the values that have been input.

Example of file contents:  The range of values input correspond to image contrast.

Ørepresents the Return key

0Ø
2Ø
4Ø
8Ø
16Ø
.
.
.

User Tips
* Image data and default display

Display formats when the image window was opened and when the Trimming dialog was opened
will depend on the image data types.

• BAS series (BAS1000/1500/2000/2500/3000/5000) ........... (Exponential + Negative) display
• FLA series (FLA2000/FLA2000G/FLA3000/FLA3000G) ..... (Exponential + Negative) display
• FDL5000 ............................................................................... (Linear + Positive) display
• LAS series (LAS1000/1000C/1000plus) .............................. (Linear + Negative) display
• Import files (Custom, TIFF, PICT) ........................................ (Linear + Positive) display
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5.3 Enhancing Contrast

Range Scope...  K

Range Scope is a function for enhancing the contrast of a portion that has
been arbitrarily selected for display from the image file. With an 8-bit image,
there will be almost no change, but for an image with contrast exceeding 8
bits, the contrast level will be concentrated in a narrow range; it is possible
to achieve clearer display by using Range Scope function on this portion (of
narrow range) to compress it.

Note: Range Scope function only changes the display and does not at all influence
the quantitative accuracy.

1 Select Range Scope... from the Image menu.

2 Drag the View Scope frame displayed on the image and move it to the region
of interest. (The inside of the box will be displayed in the lower right View
Scope magnified.)

Range Scope box

View Scope frame

5.3  Enhancing Contrast

View Scope
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3 Drag the adjuster  in the Range Scope box and arbitrarily set the
contrast level.

5 Click OK. (The image will then be redisplayed at the set contrast level.)
Click the Reset to cancel it.

Green

Red

4 Click the  to select it, the following dialog will be displayed.
Input the desired values directly.
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5.4 Displaying an Entire
Image

View

Even when enlargement has been done or the window size modified, it is
always possible to display the entire image and determine the region of
analysis. Image area can also be scrolled.

1 Select View from the Window menu.

2 The View window for the entire image will be displayed.

Green frame: Image area developed in memory. To move, drag while holding the option

key down.

Red frame: Position displayed on current image area. Can be scrolled in realtime

within the green frame.
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5.5 Displaying Informations
Related to Image

Info

Image size and pixel intensity can be displayed.

1 Select Info from the Windows menu.

5.5 Displaying an Entire Image

2 The Info bar will be displayed beneath the Menu bar.
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Quantifying an Image

C
Part
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1. Four Analysis Modes Image Gauge has four analysis modes: Annotation, Quant, Profile, and
Distance. Analysis tools  have been grouped and stored according to each
analysis mode. (However, some analysis tools are used in common by
each mode.)
Switch between modes by using the pulldown menu from the Mode selec-
tor.

1.  Four Analysis Modes

Note:  Annotation mode will be in effect immediately after an image has been
opened.

An overview of the four modes is presented below.

Annotation Used for DTP operations, such as writing text or arrows
onto the displayed image or bringing in other figures.

Quant Measures the radioactivity within a specified region.
The mouse is used to enclose (define) the region for
measurement, and the radiation dose within that region
is displayed in terms of units of  photostimulated lumi-
nescence (PSL) or cnt or LAU in the standard. (If an
arbitrary unit has been set, it is also possible to display
results in terms of it.)
This mode can be used to apply background subtrac-
tion, setting of standard values, and group formation,
etc., to quantified results.

Profile/MW Measures the PSL value for the designated region and
displays a related profile graph.
Quantified measurement and background subtraction
can also be done on the profile graph obtained.
Also, molecular weight can be measured.

Distance Measures distance and angles.
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2. Using the Analysis Tools

2.1 Analysis Tools Com-
mon to Each Mode

Pointer Tool

2.  Using the Analysis Tools

Explained here are the analysis tools stored within and used in common
by all four modes.

The objects made with the tool box in each mode can be selected (acti-
vated).
(It is possible to select more than one object at one time.)
In the example shown below, operations for selecting objects  made with
the Oval tool in Quant mode are shown.

1 Select the Pointer tool (  )from the tool box.

2 The 3 objects below, which were created with the Oval tool, will be used
in this example. (As these objects have not yet been selected, they will
be displayed in blue.)

3 To select No. 3, place the mouse pointer on it and click. (The selected
object — No. 3 — will change to red.)

Grow handle

Note:  By dragging the handles that appear with the selected object, it is possible to
adjust the object.
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4 To choose multiple objects, drag the region so that it includes all of the
desired objects, which will allow all of them to be selected at once.

2.1  Analysis Tools Common to Each Mode

Note:  When multiple objects are selected (displayed in red), it is possible to delete
them (with the delete key), move them (by dragging), and conduct other operations
on them all at once.

To immediately adjust an object after creating it with the other tools for each mode,
you can press the Tab key to select the Pointer tool.
To recreate objects, press the Tab key once more and return to the original tool.

One-touch
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It is possible to display the coordinates of any position (pixel) on the image,
its QL value, PSL value, cnt value, LAU value (or any newly set unit sys-
tem).

1 Select the Density Picker tool (  ) from the tool box.

Density Picker Tool

2 When the mouse pointer is moved inside the image, it will change to   .
At the desired position (pixel) on the image, hold down the mouse button.
The coordinates of the clicked position (pixel), the QL value, PSL value or
LAU value (standard) will be displayed on the right of the tool box.

* When the Info bar is displayed, information on the clicked position (pixel) will
be displayed in the Info bar.

4 If  the command (     ) key is held down and the screen clicked once more, the
XY axes of the coordinates will disappear.

PSL valueQL
valueCoordinates (X,Y)

3 Or, by holding down the command (     ) key and clicking a point on the
screen, the XY axes of the coordinates will appear on the image and the
XY coordinates will appear on the right of the tool box. To move the
axes, use the mouse or the arrow keys on the keyboard. (The XY
coordinates will change in realtime in accordance with the movement.)
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QL, PSL, cnt/LAU value:

The QL value on the image data read with the IP Reader is the gradation-
divided value of the image data read using logarithms. The PSL value is the
linear value derived by performing operations on the sensitivity, latitude and
contrast of the QL value at the time it was originally read. However, for the
image read with the IP Reader (FDL-5000) for Microscopy, the cnt value
(PSL value multiplied by 31.251 of coefficient) is displayed. For the fluores-
cent image read with the IP/Fluorescent Reader (FLA-2000/2000G), the
LAU value is displayed as a unit that corresponds to the PSL value. This
way, even if the reading conditions for images differ, as long as their energy
levels are the same, a uniform PSL value will be expressed. When a unit
system other than PSL has been set, operations will be performed based
on the QL value.
With the import function, the QL value will be displayed even for opened
image data. This value will depend on the hardware or software used to
create the image data.

2.1  Analysis Tools Common to Each Mode
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This tool is used to enlarge or reduce a displayed image.

1 Select the Magnifying Glass tool (  ) from the tool box.

Magnifying Glass
Tool

2 When the cursor is placed inside the image, it will change to  .

3 When the mouse is clicked on the image, the image will be enlarged
with the point clicked serving as the center. (With each click, magnifica-
tion will increase, 2, 4, and 8 times.)

Enlargement ratio
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4 To return an enlarged image to its original state, hold the shift key on
the keyboard down and click. With each click, the image will be
reduced. (When the shift key is pressed, the cursor will change to  
.

By double-clicking the tool box, you can restore the enlargement ratio to its original
status.

QUICK

In each mode, even if a different tool has been selected, by pressing the Ctrl key on
the keyboard, the Magnifying Glass tool will change to selected status.One-touch
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This tool is used to scroll an image.

1 Select the Hand tool (  ) from the tool box.

Hand Tool

3 Another method for changing the display position is to use the mouse on
the scroll bar (right or bottom edges).

QUICK

In each mode, even if a different tool has been selected, pressing the option key on
the keyboard will allow the hand tool to appear in selected status.One-touch

By double-clicking the  on the tool box, you can restore the scroll  to its initial
status.

Scroll bar

2 Place the cursor inside the image and drag the mouse. (This will cause
the portions of the image not displayed to appear on the screen.)
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2.2 Annotation Mode

Image Selector tool

2.2  Annotation Mode

The Image Selector tool is used for clipping an image out and for cut and
save functions.

1 Select the Image Selector tool (  ) from the tool box in Annotation
mode.

2 When the cursor is placed inside the image, it will change to   . Drag it
to select what you want to clip out.
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3 Select Clip Image... from the Image menu.

2.2  Annotation Mode

4 When the Image Resize dialog is displayed, select the desired magnifi-
cation ratio and click OK.
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5 The clipped image will be displayed on the screen. Even if the original
image is modified, the necessary image (before modifying) can be left
displayed. It can also be used for copy and paste functions.

2.2  Annotation Mode

Close box
Click here to close
the window.

6 By clicking the  on the tool box while holding down the option key,
you can display the Enter Rect Coordinate dialog. Input  values within it
to set the size of the rectangle as desired.

You can select the entire image by double-clicking the  on the tool box.

QUICK
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This tool is used to overlay text on an image.

1 Select the Text tool (  ) from the tool box in Annotation mode.

Text Tool

2.2  Annotation Mode

2 When the cursor is placed inside the image, it will change to  .  Place the
cursor  at the point you want to overlay text and click. (The Text & Font
dialog will appear.)

3 Input to the dialog box the text you want to display and use the pulldown
menu to make selections for display direction, font, style, character size,
and display color.
Use  :Draw Vertical when you want to write text vertically.

Note: Japanese text cannot be written vertically.
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4 If you end by clicking OK, the text will appear on the image under the set
conditions.

5 If you double-click the created text with the Pointer tool, the Text & Font
dialog will reappear, making it possible to redo settings.
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This tool is used to overlay arrows on an image.

1 Select the Arrow tool (  ) from the tool box in Annotation mode.

2.2  Annotation Mode

2 When the cursor is placed inside the image, it will change to  . Drag from
the place on the image where you want to start the arrow to the place where
you want to end it and an arrow will be written there. (The ending point is
where the head of the arrow will be.)

4 If you double-click the Arrow tool, an Arrow dialog like the following will
appear. In this dialog, you can modify the settings for arrows.

If you double-click the  on the tool box, the Arrow dialog will appear, allowing
you to prepare settings in advance.QUICK

Arrow Tool

Grow handle

3 To correct the length and angle of the created arrow, select the pointer tool
and drag the grow handle in the figure below.
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Info Stamp Tool This tool is used to display the file name and other parameters for an
image.

1 Select the Info Stamp tool (  ) from the tool box in Annotation mode.

2.2  Annotation Mode

2 When the cursor is placed inside the image, it will change to       . Click and
an Information Stamp dialog like the following will appear.

3 Each item within the dialog can be selected by clicking. (A check mark
will appear to the right of items that have been selected.)
To undo a selection, click the check mark for it.
(The check mark will disappear and the selection will be undone.)
Only the items selected in this dialog will be displayed on the image.
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4 After selecting the items you want to display, click OK. The selected
items will be displayed on the image.

2.2  Annotation Mode

5 If you double-click the Info Stamp you have created with the Pointer tool,
you can reset the information.

QUICK

If you double-click the  on the tool box, the Stamp Setup dialog will appear,
allowing you to prepare font and other settings in advance.



C - 18

2001. Dec.   Version 1.0

Scale Bar Tool This tool is used for displaying the scale bar on the image.

1 Select the Scale Bar tool (  ) from the tool box in Annotation mode.

2.2  Annotation Mode

2 When the cursor is placed inside the image, it  will change to   .

If you click it on the image, a Scale Bar dialog like the following will be
displayed.

 Option Edge Lines For selecting whether or not to have vertical lines on the edges
of the scroll bar.

3 Select the length of the scale (bar), the unit, edges (or not), etc., and
then click OK. A scale bar will then be displayed on the image.

4 If you double-click the scale bar you have created using the Pointer tool,
you can redo the settings for it.
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This tool is used to bring a PICT file into an image.

1 Select the PICT Stamp tool (  ) from the tool box in Annotation mode.

PICT Stamp Tool

  

2.2  Annotation Mode

2 When the cursor is placed inside the image, it will change to . Click and
a selection dialog like the following will be displayed. From it, select the
PICT file that you want to bring in and click Open.

3 An Image Resize % dialog like the following will appear. After you set
the size of the image you want to bring in and click, the PICT file will be
brought onto the image.
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In the above example, Profile has been brought in over the image
and displayed.

4 Using the Pointer tool, double-click the PICT file that has been
brought in to reposition it if desired.

Note: Using Copy & Paste, you can bring in data from other applications.
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It is possible to put a desired comment on an Info Stamp.

1 Select File Info... from the File menu.

2.2  Annotation Mode

Menu Functions
Related to
Annotation

2 The File Information dialog will appear. Click the Comment input
section on the list.

3 Input the desired characters in the input box and click Change.

Comment input  box
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4 After OK is clicked, by checking the Information Stamp dialog for
the Info Stamp tool, you can display the input comment.

Note:  By selecting the line feed code with the Delimiter Option and clicking
Export... , it will be possible to use the file information with Sun and MS-DOS.
An information file will be created for this purpose.
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2.3 Quant Mode

Rectangle Tool

This tool is used to enclose a desired region with a rectangle.

1 Select the Rectangle tool (  ) from the tool box in Quant mode.

2.3  Quant Mode

2 Place the cursor on the edge of the desired region and drag it to enclose
the region.
(To enclose it with a square, drag while holding the shift key down.)

3 When the region has been appropriately enclosed, release the button on
the mouse. (At this time, the area will be selected automatically and
displayed in red.)

Grow handle

Notes:
1 By dragging the four grow handles (which are red) with the Pointer tool, you can

freely modify the size.
2 By displaying the Info bar, informations concerning the ROI's start and/or end

points can be confirmed.
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This tool is used to enclose the desired region in a freehand curve.

1 Select the Freehand tool (  ) from the tool box in Quant mode.

Freehand Tool

2.3  Quant Mode Tool

2 Place the cursor at one end of the desired region  and hold down the
mouse button (do not release it).

3 When the mouse is dragged with the button held down, a freehand
curve will be drawn. Drag the mouse to enclose the desired region.

Start point

End point
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4 When you release the mouse button at the end point, it will be con-
nected directly to the starting point.
(At this time, the area will be selected automatically and displayed in
red.)

Notes:
1 By dragging the grow handle (red) with the Pointer tool, you can freely change

the size.
2 If you double-click the tool box, the Trace Resolution dialog will appear. By

selecting the desired number of pixels, you can set the number of pixels
between points.

2.3  Quant Mode
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This tool is used to enclose the desired region in a polygon.

1 Select the Polygon tool (  ) from the tool box in Quant mode.

Polygon Tool

2.3  Quant Mode

2 Place the cursor at one end of the desired region and click to define the
starting point of the polygon that will enclose the region.

3 When the mouse is moved with the mouse button released, a corre-
sponding straight line will be drawn from the starting point.
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4 Click the place on the polygon at which you want to end the line seg-
ment. (This will be a fixed point.)

5 When the mouse is moved with the mouse button still released, a
straight line will be drawn from the point just fixed.

6 Repeat the preceding step as many times as necessary and enclose the
shape of the desired region.

7 When you double-click the last point, a straight line will connect it to the
starting point. (At this time, the area will be selected automatically and
displayed in red.)

2.3  Quant Mode

Note: By dragging the grow handles (red) with the Pointer tool, you can freely
modify the size.
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This tool is used to enclose the desired region in an oval.

1 Select the Oval tool (  ) from the tool box in Quant mode.

2 Place the cursor at the edge of the desired region and drag to enclose it.
(To enclose the region in a circle, hold down the shift key and drag.)

3 When the region has been enclosed, release the button on the mouse.
(At this time, the area will be selected automatically and displayed in
red.)

Oval Tool

Grow handles

Note:   By dragging the grow handles (which are red) with the Pointer tool, you can
freely modify the size.
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Slanted Rectangle
Tool

This tool is used to enclose the desired region in a slanted rectangle.

1 Select the Slanted Rectangle tool (  ) from the tool box in Quant
mode.

2.3  Quant Mode

2 Place the cursor at the edge of the desired region, drag it briefly in the
direction you want to measure, and release the button on the mouse. At
this time, the direction will be determined by these 2 points (the first one
set and the second one dragged to).

3 When the desired region has been enclosed, click the mouse. (At this
time, the area will be selected automatically and displayed in red.)

Rotation handle

Note:  By dragging the rotation handle (green) and the grow handle (red) with the
Pointer tool, you can freely modify the size.

Grow handle
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This tool is used to enclose the desired region within a ladder.

1 Select the Ladder tool (  ) from the tool box in Quant mode.

2.3  Quant Mode

2 Place the cursor at the edge of the desired region, drag it briefly in the
direction you want to measure, and release the button on the mouse. At
this time, the direction will be determined by these 2 points (the first one
set and the second one dragged to).

Ladder Tool
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3 When the desired region has been enclosed, click the mouse.

2.3  Quant Mode

Slide handles

4 By moving the mouse to the first position marked and clicking it, you can
set a dividing line (which will move along with the mouse). Click the
points at which you want to add dividing lines. End with a double-click.
(At this time, the area will be selected automatically and displayed in
red.)

Rotation handle
Grow handle
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Note:  With grow handle (red) and rotation handle (green), you can freely change
size and angles. By dragging the slide handles (blue), it is possible to change the
position of the dividing lines.

If you undo the selection, the display will change to something like the
following.
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Matrix Tool This tool is used to enclose the desired region in a matrix.

1 Select the Matrix tool (  ) from the tool box in Quant mode.

2.3  Quant Mode

2 Place the cursor at the edge of the desired region, drag it briefly in the
direction you want to measure, and release the button on the mouse. At
this time, the direction will be determined by these 2 points (the first one
set and the second one dragged to).
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3 When the desired region has been enclosed, click the mouse.

2.3  Quant Mode

4 The Matrix Dimension dialog will be displayed, so in the input column in
the dialog, input the desired matrix size from the keyboard. (The
smallest matrix cell will be 2mm.)
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5 Click OK to display the matrix box to be used for quantification. (At this
time, the area will be selected automatically and displayed in red.)

Note: By dragging the rotation handle (green) and grow handle (red) with the
Pointer tool, you can freely modify the size and angles.

When the selection is undone, the display will change to something like the
following.
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Free-Division
Matrix Tool

This tool is used to enclose the desired region within a matrix with
freely set divisions.

1 Select the Free-Division Matrix tool (  ) from the tool box in
Quant mode.

2.3  Quant Mode

2 Place the cursor at the edge of the desired region, drag it briefly in
the direction you want to measure, and release the button on the
mouse. At this time, the direction will be determined by these 2
points (the first one set and the second one dragged to).

3 When the desired region has been enclosed, click the mouse.



C - 37

2001. Dec.   Version 1.0 2.3  Quant Mode

4 When the cursor is placed inside the enclosed area, a slice line will
be displayed in first direction. (This direction will be the direction in
which dragging was done from the first point.) Click in order the
points at which you want to make slices and double-click the last
point.

5 A slice line will appear in a second direction. As you did before, click
in order the points at which you want to make slices.
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6 When you double-click the last point, you will have created a matrix
that has been freely divided.

Slide handle
Grow handle

Rotation handle

Note:  By dragging the rotation handle (green) and grow handle (red) with the
Pointer tool, you can freely change size and angles. Using the slide handle (blue),
you can change the position of the slice lines.

When the selection has been undone, the display will change to some-
thing like the following.
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Automatic Band
Tool

Automatically recognizes the bands within the specified lane.

2.3  Quant Mode

2 Place the crosshair at the starting point of the desired region and drag
the mouse in the direction that the lanes will unfold, to the end of the
lanes. Release your finger from the mouse button. At this time, the
direction will be determined by these two points -- the first point and the
point at which you released the mouse button after dragging the mouse.

1 Select the  Auto Band Tool from the tool box in Quant mode.
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3 With your finger still off the mouse button, move the mouse. When
you have enclosed the entire region of the lanes you want recog-
nized, click the mouse. At this time, if you have enclosed too large
an area, you will not be able to have the lanes correctly recognized.

Note:  Up until you click the mouse button and define the region, you will be
able to freely modify the size of the specified frame by using the point from
which you began dragging as a fixed point.

2.3  Quant Mode
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4 The Quant Auto Lane & Band dialog will be displayed. Input the
number of lanes in the input box in the dialog.

2.3  Quant Mode

Assign Lanes Evenly: Lanes of the same width are placed within a rectangle with the
same amount of space between them. The lanes on both edges
are positioned to touch the rectangle.

Find Lanes: Creates lanes by recognizing lane widths, numbers, and positions
from the image.

Same Lane Width: Makes lane width even.
Lane Count: Input when the number of lanes has been set ahead of time.
Band Parameter: The larger the number that is input, the more the degree of band

separation is improved.

5 Click OK. The lanes and bands in the specified region will be auto-
matically recognized.
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Correcting a Ladder/
Freehand Matrix

Corrects existing ladders and freehand matrixes, and automatic band
recognition.
When the Slide Handle has been specified with the Pointer  and the 
key is pressed, the Pointer will change to   . If you drag the mouse in this
condition, the slide will be copied. If you press the shift key, the Pointer will
change to  . If you click the mouse in this condition, the slide will be
deleted.



C - 43

2001. Dec.   Version 1.0 2.3  Quant Mode

Titer Plate Tool

* When the  Titer Plate Tool has been specified and clicked on the
image, the plate used the last will be displayed. (The default in this
software is 96 holes).

2 The Dots Properties dialog as shown below will appear. Specify plate
conditions.

This tool is mainly used to specify fluorescent image areas using the
titer plate.

1 Select the  Titer Plate Tool from the tool box in Quant mode.

Format:
Horizontal: Enter the number of horizontal wells.
Vertical: Enter the number of vertical wells.

Direction: Select how to display the index.
Diameter: Enter diameter of the well in unit of mm.
Pitch: Enter the distance between horizontal wells and also that between

horizontal and vertical wells in unit of m.
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3 Click    and then click the cursor on the image.
The selected plate will be displayed.

Rotation handle

4 The plate position can be adjusted by mouse dragging and the angle
by dragging the rotation handle.

5 The diameter of the well and the distance between horizontal wells and that
between horizontal and vertical wells can be re-set in the Dots Properties
dialog that appears by double-clicking the plate on the image.
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Magic Wands Tool
  

2.3  Quant Mode

This tool is used to semi-automatically enclose the desired region.

1 Select the Magic Wands tool (  ) from the tool box in Quant mode.

2 When the cursor is placed inside the image, it will change to .
Place the    cursor on the region you want to enclose (without letting
go of the mouse).
At this point, the region can be drawn automatically. Drag to enclose the
region in the best way and then release the mouse.
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3 At this time, the area will be automatically selected and outlined in
red. If you want to make fine adjustments, select the Pointer tool
from the tool box and then drag the grow handle.

2.3  Quant Mode

Note:  If you double-click the  on the tool box, the Trace Resolution dialog
will appear. By selecting the desired number of pixels, you can set the number
of pixels between points.
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This tool is used to modify the shape of ROI.
It is used for ROI created with the Free Hand tool and Polygon tool.

1 Select the Free Edit tool,  , from the tool box in Quant mode.

2 When the mouse pointer is placed inside the image, it will change to
.

2-1 Partial deletion
Drag the mouse and with the Pointer mark off 2 places on the
ROI.

2.3  Quant Mode

Free Edit Tool

When the mouse is released after the places have been marked
off, the Pointer will change to .
Place the  above the portion you want to remain and click to
have the ROI edited.

Release the mouse after the places have been marked, place
the  above the original ROI, and click to edit.

2 -1 Partial addition
The same as for a deletion, use the Pointer to mark off 2 places
on the ROI.
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Menu Functions Related
to Quant

Making an ROI Data
File

Menu Functions Related to Quant

By filing a created ROI (Region of Interest; made and enclosed with
tools in Quant mode), it is possible to call it up for other images and
reuse it.

1 Using the Pointer tool, select the ROI that you want to save.

2 Select ROIs... from the Export File submenu of the File menu.
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3 Set the file name and destination (folder it should be stored in) and
then save it.

Menu Functions Related to Quant

4 When you want to use it on a different image file, open the file in
Quant mode and select ROIs... from the Import submenu of the File
menu to import it.
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Using Duplicate This function is used to duplicate single or multiple objects that have
been created.
On an image that has multiple lanes, as shown below, we will use as an
example the procedure for quantifying each lane in the same format.

1 Quantify one lane. With the Pointer tool, activate the ROI that you
want to copy.

2 Select Duplicate from the Edit menu.
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3 A copy of the selected ROI will be displayed on the screen. (It will be
as selected.)
Drag the duplicated ROI with the Pointer, move it to another lane,
and readjust the size and position, thus making it into the desired
ROI.

QUICK

You can duplicate an object by activating it and then dragging it with the
command key held down.

Using Duplicate
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Saving Quantification Areas 1 Activate (red) the quantification setting area(s) on the image.

2 Select Export File from the File menu and then ROIs/Lanes from the
submenu.

3 Input the file name in the open dialog and specify the destination
for saving.

4 The saved file will be displayed as the icon shown below.
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Retrieving the Saved
Quantication Areas

1 Select Import File from the File menu and then ROIs/Lanes from the
submenu.

2 Specify the saved quantification area in the open dialog and open it.

3 The offset values can be specified in the Position dialog below.
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Image A

100pixel

100pixel

Image B

100pixel

100pixel

Image B

100pixel

50pixel

50
pi

xe
l

100pixel

Retrieving the Saved Quantification Areas

In the saved quantification area, the position on the image when
the area was saved is stored.

For example, when retrieving the quantifi-
cation area stored as shown at the left on a
different image B, the area will be posi-
tioned on Image B according to the image
positioning conditions on Image A (at the
100 pixel/100 pixel position when viewed
from the top left corner), assuming that

Left offset: 0 pixel and
Top offset: 0 pixel

in the Position dialog.

When offset values are changed to Left: 50
pixels and Top: 50 pixels on the Image B in
the Position dialog, the quantification area
will be shifted as shown below.

* If the quantification area is not positioned on the image after offset has
been specified, it will be positioned out of the image area. Make sure to
adjust the offset value so that the quantification area is within the image
area.
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1 Select Quant Result from the Windows menu.Displaying Quant
Results

Displaying Quant Results
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2.4 Profile/MW Mode

Line Profile Tool

The Line Profile tool is used to select (and display) a line segment from an
image and measure its corresponding PSL profile.

1 Select the Line Profile tool (  ) from the tool box in Profile/MW mode.

2.4  Profile/MW Mode

2 When the cursor is placed inside the image, it will change to +.  Place it
on the top center of the lane and drag it over the desired region. Re-
lease the mouse button. (The line profile will be displayed in red.)

Note:  Drag the lane while holding down the shift key on the keyboard to
draw a vertical or horizontal lane.

QUICK

Select the Peak Aid from the Option submenu from the Analysis menu to display the
Pak Aid display.
(See p. C-69, Peak Aid Function.)

Line Profile tool

Start Line tool
Smile Lane Profile tool

Lane Profile tool

Auto Lane tool

By dragging the rotation handle (red) with the Pointer tool, you can
change the lane length and the angle. By dragging it with pressing
the command key, only the angle can be changed.
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Lane Profile Tool

  

This tool is used to connect 2 points on a lane of set width and measure the
profile of the lane.

1 Select the Lane Profile tool (   ) from the tool box in Profile/MW
mode.

2 When the cursor is placed inside the image, it will change to    .
Drag the cursor to one end of the lane and click.

Rotation handle

QUICK

3 Double-clicking the created lane profile with the Pointer tool makes it
possible to redo the width settings.

Double-click the  on the tool box to display the Profile Width dialog and set the

lane width prior to drawing lanes.

By dragging the rotation handle (red) with the Pointer tool, you can
change the lane length and the angle. By dragging it with pressing
the command key, only the angle can be changed.
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Smile Lane Profile
Tool

This tool is effective for setting a smiled lane.

1 Select the Smile Lane Profile tool (  ) from the tool box in
Profile/MW mode.

2.4  Profile/MW Mode

2 When the cursor is placed inside the image, it will change to .
Place the  cursor at the top of the lane and click.
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3 Next, click the point on the profile you want to bend and then click
the 3rd and 4th points and bands along the lane. End by double-
clicking to finish setting the region. (The outline of the Smile Lane
Profile will change to red.)

2.4  Profile/MW Mode

Note: By dragging the rotation handle (green) with the Pointer tool, you can
change the angle.

4 By double-clicking the created Smile Lane Profile with the Pointer
tool, you can redo the width settings.

Double-click the  on the tool box to display the Profile Width dialog, making it

possible to set the lane width prior to drawing lanes.
QUICK

Rotation handle
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Start Line Tool

  

This tool can be used to align the starting lines when drawing a Profile Line
for each lane.

1 Select the Start Line tool (  ) from the tool box in Profile/MW mode.

2 When the cursor is placed inside the image, it will change to X. Drag the
mouse on the image from one point to another to display the start line
you have created.
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3 To create regions for the Line Profile, Lane Profile, and/or Smile
Profile, by dragging from the start line, the starting points for each
profile will be automatically aligned.

2.4  Profile/MW Mode

Note:  If the profile region is  moved after it has been created, it will be
released from the start line. In addition, the start line cannot be moved or
adjusted.
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Automatic Lane/Band
Tool

Automatically recognizes lanes, bands and/or BG within a specified
area.

2.4  Profile/MW Mode

1 Select the  Auto Lane/Band tool from the tool box in Profile/MW
mode.

2 Place the crosshair at the starting point of the desired region and drag
the mouse in the direction that the lane will unfold, to the end of the
lanes. Release your finger from the mouse button. At this time, the
direction will be determined by these two points -- the first point and the
point at which you released the mouse button after dragging the mouse.
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3 With your finger still off the mouse button, move the mouse. When
you have enclosed the entire region of the lanes you want recog-
nized, click the mouse. At this time, if you have enclosed too large
an area, you will not be able to have the lanes correctly recognized.

2.4  Profile/MW Mode

Note: Up until you click the mouse button and define the region, you will be
able to freely modify the size of the specified frame by using the point from
which you began dragging as a fixed point.

4 The Profile Auto Lane & Band dialog will be displayed. Select each
item as necessary.

Assign Lanes Evenly: Lanes of the same width are placed within a rectangle with the
same amount of space between them. The lanes on both edges
are positioned to touch the rectangle.

Find Lanes: Creates lanes by recognizing lane widths, numbers, and
positions from the image.

Same Lane Width: Makes lane width even.
Lane Count: Input when the number of lanes has been set ahead of time.
Auto Peak Search: Automatically recognizes peaks (bands) in lanes.
Peak: Automatically recognizes peaks (bands) in each lane.
Peak & GB: Automatically recognizes peaks and backgrounds in each lane.
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5 Click OK.  The lanes, lanes and bands, or lanes, bands and BG in the
specified region will be automatically recognized.
(The following illustration is an example of automatic lane and band
recognition.)

2.4  Profile/MW Mode
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Band Tool Specifies bands within lanes.

1 Select the Band tool, , from the tool box in Profile/MW mode.

2 When the Mouse pointer is placed inside the image, it will change to
( ).
Clicking the Mouse pointer above a band will mark that band.
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Menu Functions Related to
Profile/MW

2.4  Profile/MW Mode

The lane that has been quantified cannot be deleted, even pressing the
delete key or selecting the Clear from the Edit menu. The following
dialog will be displayed.

Deleting Lane

In this case, select the Delete Lane... from the Edit menu if you wish to
delete the lane with the quantified result.
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The lane width for Lane Profiles and Smile Lane Profiles can be set as
desired.

1 Select Lane Width... from the Option submenu from the Analysis menu.

2 The following dialog will be displayed. Input Profile width in terms the
number of pixels and click OK. (You can also open this dialog by
double-clicking the tool box with the Pointer.)

Setting Lane Width

2.4  Profile/MW Mode
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Setting the Peak ROI Type

2.4  Profile/MW Mode

Set the Peak ROI Type when using Auto Peak.

1 Select Peak Type... from the Option submenu of the Analysis Menu.

2 The following dialog will appear. Select the ROI type.

Point Peak: Recognizes Peak in units of 1 pixel.

Integrated Peak: Abstracts Peak from a certain width.
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Peak Aid Function Peak search functions using tools from Profile/MW and Distance modes
and Profile line extensions functions are provided.

1 Select Peak Aid... from the Option submenu of the Analysis menu.

2.4  Profile/MW Mode

Use Peak Aid: When      is clicked, a check mark will appear and this function will be

available for use. At this time, PK Aid On will be displayed on the side

of the tool box.

Search Area: With the point clicked with the mouse serving as the center, a fixed

area is searched and the point on the highest peak is automatically

determined. Set the number of pixels for the area of automatic

search.

Profile Extend: When the Profile Line is specified and the center of the peak is

selected, the distribution on the outside is not known. Here, this

function can be used to automatically extend the Profile Line on

both sides by "n%," the value of which is input in the dialog.

2 The following dialog will appear. Set the necessary items.
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Ex.: When Profile Extend is used (left) and when it's not (right)
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Saving the Lane 1 Active (red) the lane on the image. (Multipe lanes can be selected.)

2 Select Export File from the File menu and then ROIs/Lanes... from
the submenu.

3 Input the file name in the open dialog and specify the destination
for saving.

4 The saved file will be displayed as the icon shown below.
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1 Select Import File from the File menu and then ROIs/Lanes from the
submenu.

2 Specify the saved lane in the open dialog and open it.

3 The offset values can be specified in the Position dialog below.

Retrieving the Saved
Lane
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In the saved lane, the position on the image when the lane was
saved is stored.

For example, when retrieving the saved
lane as shown at the left on a different
image B, the lane will be positioned on
Image B according to the image position-
ing conditions on Image A (at the 100
pixel/100 pixel position when viewed from
the top left corner), assuming that

Left offset: 0 pixel and
Top offset: 0 pixel

in the Position dialog.

When offset values are changed to Left: 50
pixels, Top: 50 pixels on the Image B in the
Position dialog, the lane position will be
shifted as shown below.

2.4  Profile/MW Mode

Image A

100pixel
100pixel

Image B

100pixel
100pixel

Image B

100pixel

50pixel

50
pi

xe
l

100pixel
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Displaying Profiles 1 Select Profile from the Windows menu.

2.4  Profile/MW Mode

The profile selected with the Profile tool will be displayed.
There are 2 sub-modes (Display and Measure) in the Profile mode.
The default setting is the Measure mode.
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2.5 Distance Mode

Distance Tool 1 Select the Distance tool  from the tool box in Distance mode.

2 When the cursor is placed inside the image, it will change to  .

Click the point on the image at which you want to begin measurement.
Next, move the mouse to the first point that you want to measure (the
measurement line will be displayed) and click.
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4 To view (display) results of measurement, select Distance Result
from the Windows menu.
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Interval Tool This tool can be used to measure the distance between curves by using a
parallel line that reaches between the two points you want to measure,
allowing for accurate measurement of edges.

1 Select the Interval tool (  ) from the tool box in Distance mode.

2.5  Distance Mode

2  When the mouse cursor is placed inside the image, it will change to
 . Click on the image the point at which you want to begin measurement.

Next, move the mouse (the measurement line will be displayed) to the point
at which you want to end measurement and click.
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3 To view (display) the results of distance measurement, select
Distance Result from the Windows menu.

2.5  Distance Mode
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Angle Tool This tool can be used to measure any angle on an image.

1 Select the Angle tool (  ) from the tool box in Distance mode.

2.5  Distance Mode

1) Click

2) Click

2 When the cursor is placed inside the image, it will change to  . Click 3

points on the image to create the angle that you want to measure.

3) Click
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3 To view (display) results of measurement, select Distance Result
from the Windows menu.

2.5  Distance Mode
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Analyzing Quantification Results

D
Part
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1. Analysis in Quant Mode

Selection of Displayed
Items

Option  -  List

1 Select Quant Result from the Window menu. Quantification results
will be displayed similarly to the following.

2 You can select the items you want to have displayed when measure-
ment results are displayed. Select List on the Option submenu from
the Analysis menu.

Quant List box

Data information

Index

Group

Area name

Area of the measured region

Value with background subtracted

Ratio against the standard value

Percent of group each value represents

Minimum pixel value in each ROI:
converted value/pixel

Known value

Calibrated value

Measurement
number

Radiation dose

Value per 1mm2 with background subtraction

Standard deviation against all
the pixels in each ROI

Maximum pixel value in each ROI:
converted value/pixel

Value per 1mm2
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3 A Quant List Item dialog like the following will be shown.
By clicking the checked boxes, you can decide whether to display the
items they represent or not.

Click the Quant List box to display the Quant List Item dialog.

Quant List box

QUICK
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Dividing Measured
Regions into Groups

Group   G

Depending on the experiment method, it is possible to divide the entire
region to be measured into groups of regions based on differences in
factors (conditions) and display them.

1 While holding down the Command key, click (and thus define) the
measurement Nos. that you want to form into one group. At this time, as
long as the position clicked is something other than Area Name, you can
click anywhere within the line for the region.

1.  Analysis in Quant Mode

Method 1 To select multiple consecutive measurement Nos. at one time, click
the top measurement No. you want to select. Then, while holding
down the shift key, click the last of the Nos. you want to select. The
Nos. in between the two that were clicked will all be selected.

Method 2 Drag the mouse to anywhere except the Area Name column. The
measurement Nos. for the area thus specified will be selected.

QUICK
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2 Select Group from the Edit menu.

3 The regions that have been divided into groups will be shown on
the bottom lines of the Quant Result table. In the group column, the
group name will be displayed (name will be a letter; "A" in the
following example).

4 To undo the grouping, select the measurement No. and then select
Ungroup from the Edit menu.



D - 6

2001. Dec.   Version 1.01.  Analysis in Quant Mode

Procedure for assigning a new measurement No. to a group that has already
been selected

1 Select the measurement No. that you wish to add and drag it with the
mouse.

2 Place the cursor in  the space for the  measurement number of the group that
you wish to add, hold down the Command key (     ) and then release the mouse
button. The dragged measurement No. will be added to that group.

QUICK
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Quant Result Operations

(1) Background
Subtraction

Background

When the sample undergoes exposure, background noise always
manages to enter. If this background noise is not eliminated (sub-
tracted), sample data cannot be accurately measured. Thus, an ROI for
measuring the background is created and that value is subtracted and
displayed.

Note:  Subtraction is done by multiplying the background around the unit area
by the area of the sample data.

1.  Analysis in Quant Mode

1 Click the measurement No. of the background region in the Quant
Result table to select it. (Here, "10" will be used as an example.)

(1)-1 When there is no
group division

2 Select Local from the Background submenu of the Analysis menu.

Local For setting background within the same group only.

Global For setting background for all groups (or all the regions).
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The specified background value will be subtracted from all the regions
(bands) and the PSL-BG value will automatically be displayed on the
Quant Result table.
In the Quant Result table, in the left half of the Info column of a row in

which background was set, a  will be displayed to indicate that that
region is a background.

Note:  When no background has been specified, PSL-BG will be displayed with
BG=0.

It is possible to apply to all the groups one background that does not
belong to any of them.  However, if a background within a group has
already been set, this cannot be done. Also, the last background set
within a group will take priority.

1 Click the measurement No. of the background region in the Quant
Result table that you want to use for all groups to select it ("10" in
this example).

(1)-2 When there is
group division
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2 Select Global on the Background submenu from the Analysis menu.

3 When Global is selected,  will be shown in the Info column.

Note:  When multiple backgrounds have been set, the average value for them
can be applied as a background (for both Local and Global).
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4 As shown in the following example, when a background has been
set within a group (here, measurement No. 11 has been set in Group
A), that background will be given priority.

5 To undo a background, select the measurement No. that you want
to undo and then select None on the Background submenu from the
Analysis menu.

(2) Setting a Standard

Standard

A sample you want to quantify and an already quantified (known)
standard can be exposed on the same IP. The value for each measured
region can be displayed as a ration of the value of the measured
standard.

(2)-1 Setting a Standard
when there is no
group division

1 From the Quant Result table, click to select the measurement No. of
the standard to be used for quantification (here, measurement No. 9
has been set as a standard).
(Multiple standards cannot be set.)
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2 Select Ratio Standard from the Analysis menu.

The value for the specified standard will be set at 100 for each group.
The value for  other regions will be recalculated in kind.  The revised
values will automatically be displayed in the Ratio column in the Quant
Result table. Also, in the right half of the Info column on the line
where the standard was set, an  will be displayed to indicate that
region is the standard.
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(2)-2 Setting a Standard
for Each Group

1 Divide the regions in the Quant Result table into groups. (See p. D-4,
Dividing Measured Regions into Groups, Group.)

2 In the Quant Result table, for each group click to specify the stan-
dard to be used for quantification and select Standard from the
Analysis Menu.

The value for each specified standard will be set at 100 for each group.
The value for  other regions (bands) for each group will be recalculated
in kind.  The revised values will automatically be displayed in the Ratio
column in the Quant Result table. Also, in the right half of the Info
column on the line where the standard was set, an  will be displayed
to indicate that that region is the standard.
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1 With one measurement No. selected, select Date Info... from the
Analysis menu. The following About This Quant dialog will be
displayed.

(3) Shortcuts for
Setting Groups,
Backgrounds, and
Standards

1.  Analysis in Quant Mode

Each item in this dialog can be set.

No. Displays the measurement No. currently selected. When regions are

erased and measurement Nos. are freed up in kind, this function can

be used to reassign Nos.

Area Name box For inputting the characters that will display the Area Name. (Will be

displayed as the Area Name for Quant Result.)

Memo For inputting information for each measurement No. (Will not be

displayed in Quant Result.)

Group For changing group assignments.

Background None, Local, or Global can be set.

Standard Check to set the standard.

1 Double-click the measurement No. to display the About This Quant dialog.

2-1 By double-clicking the data information (left and right sides of the Info
column) for the measurement No., the Local background and standard
can be set.

QUICK

2-2 Click  while holding down the shift key to make Local and Global
selections.
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(4) Setting Reference
Values

Quant Options - Table...

1 It is possible to modify the standard values for % of Grp and Ratio.
Select Table on the Option submenu on the Analysis menu.

1.  Analysis in Quant Mode

Note: On the Result window, the selected Ratio will be shown in red and the selected %

of Grp will be shown in green. When the same item for the image is used, that item will

be shown in light blue.

2 Click to select each item that you want to set for the image.
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(5) Setting the Calibration
Curve

Calibration - New...

Create a calibration curve from the quantification results.

1 Create the ROI you will use with the calibration curve.

2 From Quant Result, click to select the data you will use for the calibra-
tion curve. To select multiple pieces of data, click the appropriate
measurement Nos. while holding down the Command key (     ).
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3 Select New... on the Calibration submenu on the Analysis menu.
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It is possible to save as a file the known values input
using Save... and to recall them using Load...

4 A Density Calibration dialog like the following will be displayed.
Here, you can input the known values of each quantification result
and set other items.

1.  Analysis in Quant Mode

Set the total volume for reference.
Set the measured value/pixel for reference.

Select the unit (value) for conversion.

Select the convert function

Select the unit for the X-axis.

Select the unit for the Y-axis.

Arbitrary numeric input column.
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Calibration curve

5 Click Curve Fit to draw the curve.

Curve box

6 Lastly, click Apply. The values in Quant Result will be converted
based on the calibration curve created.
Here, the measured values for the image will have undergone
calibration.
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7 Select Show on the Calibration submenu on the Analysis menu.
The current calibration curve dialog will be displayed.
This calibration curve cannot be updated, but saving and/or printing
are possible.  Click OK to close the display.
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2. Analysis in Profile/MW
Mode

Displaying the Profile Line

Profile

2. Analysis in Profile/MW Mode

When Profile is selected from the Windows menu in Profile mode, a
Profile line like the following will be displayed.

Profile mode has the following two submodes.
Display For modifying the graph display method.

Measure For taking measurements from the graph.

To switch between modes, use the Mode pulldown menu.

Mode Profile number
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2.1 Display Mode
   (Including common tools)

Sequential Switcher

    

When multiple profiles exist, they can be switched between in order of the
profile numbers that have been assigned to them.
Each time the   are clicked, the number of the profile for display will
change.

1 Select the profile number from the pulldown menu on the tool box.Pulldown Switcher

  

2 In Display mode, it is possible to display multiple profiles at one time.
Select Select... from the pulldown menu.
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3 The Select Profiles dialog will be displayed. Click the profiles you
wish to display at one time to select them and end by clicking OK.

4 The selected profiles will be selected all at one time (only in Display
mode).

Note:  In step 3, above, before clicking OK, it is possible to change the display color
by using the Profile Color:      pulldown menu from the Select Profiles dialog.

At this time, there will be only one selected profile (shown with a solid line).
The others will appear as unselected (shown with a broken line). To change
selection, use the Pointer tool. It is also possible to use Measure mode on a
selected profile.
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Select an object (or more than one) created with an analysis tool. It is
also possible to select a graph itself.

This tool is used to slide the graph horizontally.

1 Select the  within the graphed region and drag it to slide the graph.

Pointer Tool

  

Graph Slider Tool

  

To return a moved graph to its original position, double-click

the   on the tool box.QUICK
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This tool is used to magnify the graph horizontally without changing the
height value.

1 Select  and click a point within the graphed region. (With the clicked
point serving as the center, the graph will be magnified to twice its size.)

2 To reduce the graph, hold down the shift key and click.

Double-click the  on the tool box to restore the profile to its original state.

Horizontal Magnifying
Glass Tool

  

QUICK
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This tool is used to magnify the graph vertically without changing the width
value.

1 Select  and click a point within the graphed region. (With the clicked

point serving as the center, the graph will be magnified to twice its size.)

Vertical Magnifying
Glass Tool

  

2.1  Display Mode

2 To reduce the graph, hold down the shift key and click.

Double-click the  on the tool box to restore the profile to its original state.

QUICK
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Magnifying Glass
Tool

  

This tool is used to magnify the graph (horizontally and vertically).

1 Select  and click a point within the graphed region. (With the clicked

point serving as the center, the graph will be magnified to twice its size.)

2.1  Display Mode

2 To reduce the graph, hold down the shift key and click.

Double-click the  on the tool box to restore the profile to its original state.

Hand Tool

  

This tool is used to move (scroll) region of the image displayed.

Select  and then drag the mouse pointer on the image.

Double-click the  on the tool box to restore the profile to its original state.

QUICK

QUICK
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2.2 Measure Mode

Horizontal BG Tool Creates a horizontal BG (background) on the Profile.

1 With the Profile window in Measure mode, select the   Horizontal BG
tool from the tool box.

2 When you place the pointer within the graphed region, it will change to
 .  At this time, the PSL value of the BG line will be displayed in

realtime on the right side of the tool box, in keeping with the movement
of   .
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3 Moving the mouse, move the Pointer   to a background position and
click to set.

2.2  Measure Mode

4 By selecting Copy BG Line... from the Analysis menu, the horizontal BG
line created here can be copied and applied to another profile.
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QUICK

If you double-click the Horizontal BG tool   , the Profile Background dialog

will be displayed and the BG line will be set in accordance with the input value.

2.2  Measure Mode
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Background Tool

  

2.2  Measure Mode

This tool is used to set the background level of a graph.

1 Select  from the tool box in Measure mode.

2 When the mouse pointer is placed within the graphed region, its
shape will change as shown below.
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3 On the first peak, click what will be the starting point for the back-
ground level (the upright portion). Then, move the mouse from
point to point (they will be connected with a straight line), clicking
as you go.

2.2  Measure Mode

4 Double-click the last point.

2) Click

1) Click

Handle
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5 To erase the background, select Clear BG Line... from the Analysis
menu.

2.2  Measure Mode

Note:  The background that can be set for one profile is limited to one line. Also, by
dragging the handle on the line with the Pointer tool, you can freely change the
position.
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Spline BG Tool Creates a smooth BG (background) line on the profile.

1 With the Profile window in Measure mode, select the Spline BG tool,
, from the tool box.

2 Below, a background is created following the same procedure as
when the background tool is used.
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Integral Tool

  

This tool is used for measuring a portion from which the background
created with the Background tool has been eliminated.

1 Select the Integral tool, (  ) , from the tool box in Measure mode.

2.2  Measure Mode

2 When the mouse pointer is placed within the graphed region, its
shape will change as shown below.
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3 Measure by dragging the graphed portion (peak) that you want to
measure and releasing the mouse.

2.2  Measure Mode

4 Measure each peak by dragging it.

Drag

5 Refer to Displaying Profile Results, p.D-53.

Note: With the Pointer tool, you can freely change the left and right edges of a
peak.
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This tool is a combination of the Background and Integral tools.

1 Select the Measure Profile tool, (  ), from the tool box in Measure
mode.

Measure Profile Tool

  

2.2  Measure Mode

2 When the mouse pointer is placed within the graphed region, its
shape will change as shown below.



D - 37

2001. Dec.   Version 1.0

3 Drag from the starting point of the background level on the first
peak (the upright portion) to the next point (they will be connected
with a straight line), release the mouse button there, and measuring
will be done.

2.2  Measure Mode

4 Measure each peak by dragging it.

5 Refer to Displaying Profile Results, p. D-53.

Note:  When peaks have been deleted and added, select Renumber from the
Analysis menu to renumber the measurement Nos. for the profile graphs in
order from the left side.
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Density Picker Tool This tool is used to measure the value of one pixel on the graph.

1 Select the Density Picker, (  ) , from the tool box in Measure
mode.

2.2  Measure Mode

2 When the mouse pointer is placed within the graph, its shape will
change as shown below. At this time, the distance and the value for
one pixel will be displayed in realtime beside the tool box.
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3 Click each peak you want to measure. (The value for the position of
the cursor will be measured.)

2.2  Measure Mode

4 Refer to Displaying Profile Results, p. D-53.
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Automatic Profile
Background
Recognition

Auto BG...

2.2  Measure Mode

Automatically creates the background suitable for the smear compo-
nents from the profile.

1 With the Profile window in Measure mode, select Option from the
Analysis menu and then select Auto BG...from the submenu.

2 The Auto Background dialog will be displayed. In the input columns,
input the parameters for background recognition.
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Lowest (Horizontal Line)

Creates a horizontal BG line from the minimum value on the
profile.

Valley (Polygonal Line)

H. Ratio (A/B): %

V. Ratio (C/D): %

Creates an arbitrary BG line when the parameters for the
horizontal and vertical directions are input (set).

 H. Ratio (A/B):   Parameter set for the horizontal direction

The parameter (% value) input here becomes the standard
value when the created profile's total length (in the horizontal
direction) is taken to be 100%. The smaller % value becomes,
the more valleys are detected.

Example: As shown in the following illustration, when the
interval between valleys is 10% of the total length,
BG line "A" will be drawn  if this parameter is set to
under 10%. If it is set to 10% or more, BG line "B" will
be drawn.
(However, in this example, the influence of the
parameter for the vertical direction has not been
considered.)

2.2  Measure Mode
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V. Ratio (C/D): Parameter set for the vertical direction

2.2  Measure Mode

Valley (Spline)

Subtracts a smooth background line.

 H. Ration (A/B) and V. Ratio (C/D) are the same as Valley

(Polygonal Line).

The parameter (% value) input here becomes the standard

value when the maximum amplitude of the created profile (in

the vertical direction) is taken to be 100%. The smaller %

value becomes, the more valleys are detected.

        Example: As shown in the following illustration, when the interval

between the valley and the maximum value is 70% for

the maximum amplitude, BG line "A" will be drawn  if

this parameter is set to under 70%. If it is set to 70% or

more, BG line "B" will be drawn.

(However, in this example, the influence of the param-

eter for the horizontal direction has not been consid-

ered.)



D - 43

2001. Dec.   Version 1.0

3 After inputting the parameters, click OK on the Auto Background dialog.

4 With the Profile window in Measure mode, select BG Search from the
Analysis menu .

2.2  Measure Mode
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A background line like the following will be automatically created in
accordance with the set parameters.

Note:  When the Pointer is used to specify the valley point (when the Pointer is )
and the key is pressed, the Pointer will change to   .  In this condition, if you
drag the mouse, the BG point  will be copied. If you press the shift key, the Pointer
will change to   . If you click the mouse in this condition, the BG point will be
deleted.

2.2  Measure Mode
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Automatic Recognition of a
Profile Measurement Re-
gion

Peak Search

It is possible to automatically set a Profile measurement region.

1 In Measure mode, select Peak Search... from the Analysis menu.

 Peak : Peak will be recognized automatically.

 Peak & BG : Peak and BG will be recognized automatically.

The following dialog will appear.



D - 46

2001. Dec.   Version 1.02.2  Measure Mode

2 Similar to the following illustration, a measurement region for the
peak and BG will be automatically set.

3 Select the Pointer tool from the tool box. By dragging the broken
line on the region, you can make fine adjustments on the enclosure.

Note:  When peaks have been deleted and added, select Renumber from the
Analysis menu to renumber the measurement Nos. for the profile graphs in order
from the left side. When used together with the background tool, measurement is
also possible.

4 Refer to Displaying Profile Results, p. D-53.
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Setting Rf Rf expresses the positional relationship substance found with thin layer
chormatography, which is calculated as  a fraction.

Rf =
Distance from origin to substance
Distance from origin to solvent front

1. Select Measure mode.

2. In Mesaure mode, drag the Rf normalizer  and move from the origin
of the lane to the front. When this has not been designated, from the
starting point to the end point of the profile line will be selected.

Rf normalizer Rf normalizer reset button
By clicking this button, the
Rf normalizer will return to
its initial position.

3. Peform quantification.
Especially when using the Density Picker tool, it is possible to define
points.
( When a uniform interval has been specified, the center of the largest
peak will be the point.)
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Measuring Distance Using the Rf Value
Mode Used:  Profile - Measure
Function Overview:  Measures distance in accordance with the Rf normalizer.

With the Profile window in Measure mode, by setting the Rf normal-
izer, the distance display can be measured so that the X-coordinate of
the origin is always 0, no matter where it is moved.

2.2  Measure Mode

Initial point
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An example of moving the X-coordinate by using the Rf normalizer follows.

2.2  Measure Mode

4 When Profile/MW Result is selected from the Windows menu, Rf
will be displayed.

This point will be set to distance 0.
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Applying the Rf Value

Copy RF Ratio

It is possible to apply to another profile the distance between the front and
the origin of the Rf set for one measured lane from a profile.

1 Set the Rf that will serve as the standard.

2.2  Measure Mode

2 Display another profile lane and set only the origin.

Note: Using the Start Line tool to set the origin makes operations easier.
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3 Redisplay the profile serving as the standard and select Copy RF
Ratio... from the Analysis menu.

2.2  Measure Mode

4 Click YES to apply the standard distance to other lane(s).

Applied distance
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Setting the Profile Display
Method

1 Select Display... on the Option submenu from the Analysis menu.

2.2  Measure Mode

2 The following Profile Display dialog will be displayed. After setting
each item, click OK.

Add a mesh to the graph.

Modify scale in keeping with the
profile.

Display with log scale.

Add a margin to the upper part of
the largest peak.

Scale can be set to the desired size.
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Displaying Profile Results 1 Select Profile/MW Result from the Windows menu.

2.2  Measure Mode

2 A Profile Result table similar to the following will be displayed.
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Molecular Weight
Measurement

MW Calibration...

2.2  Measure Mode

Molecular weight is measured from the distance of phoresis.

1 Set the lanes and bands within lanes in the sample.

Recognition of these lanes and bands can be done either automatically
or manually.

When automatic recognition is set:
See C-62 for the method for using the Auto Lane/Band tools.

When manual recognition is set:
After lane setting with the Lane Profile tool (see C-67) or automatic
recognition of lanes only has been set, set with the Band tool (see
C-65).
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2 Set the lane that will serve as the standard. After clicking on the
image the lane that will be the standard (multiple lanes can also be
selected), select Set... from the Lane Standard submenu of the
Analysis menu.

2.2  Measure Mode

3 The following dialog will be displayed.

Saves kown input values as a file.
Loads kown input values as a file.
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4 Input the known molecular weights for each band in the MW column.
Select the function to be used from the Convert Function column.

2.2  Measure Mode

After setting the conditions, click .
A calibration curve will be created.
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5 If OK is clicked, along with a display (as in the following figure) of
based on already known molecular weights, the unknown molecular
weights will be measured from the calibration curve.

2.2  Measure Mode

6 If Profile/MW Result is selected from the Windows menu, the
measurement results will be displayed.
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3. Related Menu Functions
(used in both Quant and
Profile)

3.1 Modifying the Unit

3.1  Modifying the Unit

It is possible to change the unit for quantification used on the display
or in the Result window, etc..

1 Select Density... on the Preferences submenu from the File menu.

2 The following Density dialog will be displayed. Each item can be set
and the desired unit used.

*  For the unit name, up to 3 English letters can be input.
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3.2 Making Quantification
Results into a File

1 Activate the Result window that you want to save (status of 6
parallel lines displayed on the title bar on the front screen of the
desktop). The values for the items displayed at this time will be
saved.

3.2  Making Quantification Results into a File

2 Select TEXT... on the Export File submenu from the File menu.

3 When the file name and save destination is selected, a file will be
formed (in TEXT format) and the following icon will appear.
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It is possible to copy and paste the Result window (or Profile window)
onto the image.

1 Activate the Result window. Here, make sure no measurement No.
has been selected in the window.

3.3 Copying & Pasting

2 Select Copy from the Edit menu. (The window will be stored on the
clipboard.)

3 In Annotation mode, activate the image window and paste in the
Result window.

3.3  Copying & Pasting
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1 Select the measurement No. that you want to move and drag it to
the desired position.

3.4 Changing the Position
of the Measurement
No.

2 While moving the No., if you release the mouse button while
holding down the shift key, the No. for the place at which you
released the mouse and the No. you are moving will switch places.

3.4  Changing the Position of the Measurement No.
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Printing

E
Part
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With Image Gauge Ver. 4.0, printing can be done with the laser beam printer and the PG3000, PG3500,PG4000
or PSD400 high-resolution output printer (option) connected to the Macintosh.

1. Printing an Image

1.1 Printing with a Laser
Beam Printer

(1) Printing an Image

1.  Printing an Image

Images controlled by this software or entire screen can be printed out through
the laser beam printer or the PG3000,PG3500, PG4000 or PSD400 printer.

1 Activate the image window that you want to print (6 parallel lines will
be displayed on the window title bar in front of the desktop).

2 Select Print... from the File menu. The following Print dialog will be
displayed. At this time, the image window will be printed out as it is
(although modifications are possible).
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Positioning Designate the layout for the paper used in printing.

When the centering box is clicked, the image will be printed at the same

size in the center of the paper. However, by dragging the entire image, you

can freely change where it will be printed.

When size is modified via Scale:    %, the size that the image is printed

out will be modified. (When 100% is set, the image will be printed at its

actual size.) See page E-6 for printing at actual size of an image captured

from an external device (images read by other than the IP Reader or

Fluorescent Reader).

Trimming Designate (trim) the region of the image that will be printed. (Initially, the

state of the image window will be displayed.)

Note:  To position an image that has been trimmed, after designating the region to
be printed, switch back again to Positioning.

3 Select Positioning or Trimming. (The initial setting is Positioning.)

Centering box
Lay out the image so
that it will be printed out
in the center of the
paper.

It is possible to freely modify
the print-out position and
magnification.  To leave off at
a good magnification, use the
Scale  to make your
selection.
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Annotation For printing out with the image the objects made in Annotation mode.

Quant For printing out with the image the objects made in Quant mode.

Profile For printing out with the image the objects made in Profile mode.

Distance For printing out with the image the objects made in Distance mode.

* A multiple number of modes can be selected.

Page Set Up... Select the paper size.

It is possible to print out with the image the objects made with each
mode. Select the mode that has object in Information: options. Selected
mode will be checked ( ).
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4 When Options... is clicked, the following Printout Options dialog will
be displayed. After setting the necessary items, click OK.

1.1  Printing with a Laser Beam Printer

Comment For putting a comment at the edge of the image region.

Input the comment in the Comment box.

None When no comment is needed.

Top Puts the input comment at the top.

Bottom Puts the input comment at the bottom.

CLUT Puts the Color Look Up Table at the edge of the image area.

None When no CLUT is needed.

Top Puts the CLUT at the top end.

Bottom Puts the CLUT at the bottom end.

Back Specifies background color for the comment and CLUT.

None When no background color is needed.

White Specifies white for background color.

Printer Quality Determines output pixel size. (Image quality wil be changed.)

Best Applies image pixel size to output. (Results in attractive

output but printing time is long.)

Better Prints images at standard pixel size (with pixels thinned out

by 1/4).

Good Prints images with pixels thinned out by 1/16. (Output is

coarse, but printing time is short.)

Auto Prints images at best quality under memory environments

assigned to software at time of printing. Pixels will be

thinned out gradually. Printing will not be possible if

memory capacity is not sufficient even though pixels have

been thinned out by 1/16.

Adjust Width/Height Allow actual output size to be finely adjusted in increments

of 0.1%.

5 When you click OK in the Print dialog, the setting dialog for the
attached printer drive will be displayed. Set the necessary items and
print.
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Printing in actual size an image captured from an external device
(images read by other than IP Reader/Fluorescent Reader)

By adding distance information to an image, it is possible to print the
image in actual size captured by an external device.

1 Open the target image and change mode to Distance.
Measure the distance between specified points (where the actual
distance is known) and then display the result table.
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2 Activate the result table and select Distance Calibration... from
the Analysis menu.

3 When the following display appears, input the known distance
in the Known Length box.
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4 Select Print... from the File menu to display the Print dialog.

5 Select Use for Calibrated in the Print dialog below.

It is thus possible to print the image with the calibrated distance. If
Scale is set to 100%, actual size printing is possible.
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(2) Screen Dumping 1 Select Screen Dump for the File menu. Select Printer... on the
submenu of the File menu.

2 The Print dialog appears. Conduct printing in accordance with the
same procedures as those used in (1) Printing an Image.
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1.2 Printing with the PG3000,
PG3500, PG4000 or
PSD400
High-Resolution Printer
(option)

(1) Printing an Image
1 Activate the image window you want to print (6 parallel lines will be

displayed on the window bar in front of the desktop window).

2 Select Print Pictro... from the File menu. The Print by PICTRO dialog
shown below will be displayed.
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1:1 Image When Scale is 100%, output will be at the actual size. Use Options... for

fine adjustments. See page E-6 for printing at actual size of an image

captured from an external device (images read by other than the IP

Reader or Fluorescent Reader).

1:1 Pixel Image will be output with its pixels made to correspond to PICTRO dpi.

4 Select Positioning or Trimming. (The initial setting is Positioning.)

Positioning Designate the layout for the paper used in printing.

When the centering box is clicked, the image will be printed at the same

size in the center of the paper. However, by dragging the entire image,

you can freely change where it will be printed.

Trimming Determine the pixel size for output, making your selection from the 1:1

Pixel pulldown menu.

You can designate the region of the image to print. (Initially, the window

will be displayed.)

After designating the region, click Print...  and printing will be done.

It is possible to freely modify
the print-out position and
magnification.  To leave off at
a good magnification, use the
Scale  to make your
selection.

Centering box
Lay out the image so
that it will be printed
out in the center of the
paper.
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Note:  To position an image that has been trimmed, designate the region to be
printed and then switch to Positioning

Note: Paper sizes
Sizes of the paper that can be used differ depending on the connected
printer.

(1) When PG3000, PG3500 is connected:

A4/B5 or Letter/Half L (for overseas)

* When Letter/Half L is used, selecting Print Pictro... in the File menu
while holding the option key down, selection in Paper Size will be
changed.

(2) When PG4000 or PSD400 is connected:
Paper sizes that the software can handle are limitted according to
PG4000 specifications.

Available paper size is automatically changed in accordance with the
paper width specified for PG4000.

When paper width is 297mm: A3/A4
When paper width is 127mm: 2L (5R for overseas)
When paper width is 297mm (for overseas): D-Letter/Letter

Select whether to position the image horizontally or vertically in
relation to paper.

Select paper size for priting.
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Annotation For printing out with the image the objects made in Annotation

mode.

Quant For printing out with the image the objects made in Quant mode.

Profile For printing out with the image the objects made in Profile mode.

Distance For printing out with the image the objects made in Distance mode.

* A multiple number of modes can be selected.

5 It is possible to print out with the image the objects made with each
mode. Select the mode that has object in Information: options. Selected
mode will be checked ( ).

6 When Options... is clicked, the following Pictro Print Options dialog
will appear. After setting the necessary items, click OK.

Comment For putting a comment outside of the image region. Input the
comment in the Comment box.

None When no comment is needed.
Top Puts the input comment at the top.
Bottom Puts the input comment at the bottom.

CLUT Puts the Color Look Up Table at the edge of the image area.
None When no CLUT is needed.
Top Puts the CLUT at the top end.
Bottom Puts the CLUT at the bottom end.

Back Specifies background color for the comment and CLUT.
None When no background color is needed.
White Specifies white for background color.

Adjust Width/Height Allow actual output size to be finely adjusted in increments of

0.1%.

7 Click OK in the Print by PICTRO dialog and then print.
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(2) Screen Dumping 1 Select Screen Dump for the File menu. Select Printer... on the
submenu of the File menu.

2 The Print dialog appears. Conduct printing in accordance with the
same procedures as those used in (1) Printing an Image.
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2. Printing Quantified
Results

2.1 Using Quant Result
for Printing
Quantified Results

1 Activate the Quant Result window on the desktop.

3 The following dialog will appear. Select which of the two printing
methods you want by clicking.

Normal Prints out all the numbers for quantification results altogether.

Group Prints out by group, using separate pieces of paper for each.

4 When the printer driver dialog appears, print.

2 Select Print... from the File menu.
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2.2 Printing Quantified
Results using Profile
Result

1 Activate the Profile Result window on the desktop.

2 Select Print... from the File menu.

3 When the printer driver dialog appears, set the necessary items and
click the Print button.

2.3 Printing Result Table
using Distance
Result

Print the result table according to the same procedures as those used in
2.2. Profile Result above.
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3. Printing Profile Graph 1 Activate the target profile graph.

2 Select Print... from the File menu.

3 When the printer driver dialog appears, set the necessary items and
click the Print button.
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You can register other applications that you want to use in the Appli-
cations menu. By doing so, you can take arbitrarily specified data from
image or quantification results and by clicking the application once,
simultaneously start it up and save what has been specified as a file.

1 Select Entry... from the Applications menu.

1. Registering Other
Applications

3 In the following dialog, click Ok for the application that you want to
register to select it.
[In this example, Graphic Soft Canvas™ 3.5.1 (Deneba Co., Ltd.) has
been selected.]

2 When the Entry Application dialog appears, click Entry... .
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4 Make a selection for Save File Type in the Entry Application dialog.
Select Fuji when the application is L Process.  Select PICT when it is
image processing software. Select TEXT when it is word processing
or table-calculating software.

5 When OK is selected, registration will be complete.

Release the Entry
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Select the data you want to use. For example, activate the image
window in Image Gauge. (By doing so, all of the current image data
will be selected.)

1 Select Canvas from the Applications menu.

2. Launch Function

2.  Launch Function

2 The following Launch Application dialog will be displayed.
By clicking, select either Save & Launch... or Launch Only... .

 After Quit When memory is not sufficient to allow Image Gauge and the

appropriate software to be opened at the same time, turn this option

ON to quit Image Gauge and then start up the other software.

Save & Launch... After saving data in a file, starts up the appropriate software and

opens the file.

Launch Only... Without saving data in a file, starts up the appropriate software and

opens the file.
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3 Here is the image data sent to Canvas. In the following example, the
left is the image with Image Gauge and the right the image with
Canvas.

2.  Launch Function
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4 For Microsoft's Excel and Adobe's Photoshop the same procedure
can be used for Launch.

Excel)

Photoshop)
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When Copy and Paste are used with the data applications of other
functions, it is possible to use text information from quantification
results or PICT images, etc.

1 Specify the desired information for the image, quantification results,
etc. (In this example, the measurement No. from Quant Result will
be used.)

3. Copying and Pasting

2 Select Copy from the Edit menu.

3 Activate the spreadsheet software, Excel (Microsoft Co.) and paste in
a new spreadsheet.

Hereafter, this data can be handled as Excel data.
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Even if the file has been made with another application (or system), if it
is in RAW format (data-only format), PICT format or TIFF format (pro-
vided that it is an 8bit/16bit-grey TIFF, palette color TIFF or RGB color
TIFF), it will be possible to open that file in Image Gauge. Doing so will
make it possible to create a calibration curve and conduct quantifica-
tion.

1 Select Custom... (or PICT... or TIFF...) on the Import File submenu
from the File menu.

4. Opening a File

Import File
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1-1 If the file is in RAW format (data-only format), select Custom...
The following Import File dialog will be displayed. Input the
values for depth, offset, and width and height, click OK, and
open the file.

Custom

4.  Opening a File

1-2 If the file is in PICT format, select PICT... and open the file.PICT

2 Specify the name for the file in the following dialog.

1-3 If the file is in TIFF format, select TIFF... and open the file.

* The following TIFF formats can be read.
8bit/16bit-grey TIFF, palette color TIFF or RGB color TIFF

TIFF
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5. Saving the File in
Other Format

It is possible to convert Profie and Result table into the PICT or TEXT
file.

1 Select PICT... or  TEXT... from Export File of the File menu, while the
window is being activated.

2 Input the file name and specify the destination for saving. The file
will be saved with the following icons.
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It is possible to convert the image into PICT, TIFF, RAW on Fuji Film's
standard format.

1 Select PICT..., TIFF..., RAW... or Fuji Exchange Format... from Export
File of the File menu, while the window is being activated.

2 Input the file name and specify the destination for saving. The file
will be saved with the following icons.

5.  Saving the File in Other Formats

For PICT: For TIFF:

For RAW: For Fuji Exchange Format:

* The "RAW format" is the
raster file.

* Fuji Exchange Format...
If you want to analyze data saved on the Macintosh
on a different platform (Windows or Solaris) using
the Fuji (Science Systems) software (Science Lab,
BAStation), convert the data into Fuji Film's
standard format.
The Fuji Film's standard format consists of XXX.img
of the raster file and XXX.inf of the information file.
The Fuji Film (Science Systems) software opens
the raster file while viewing the information file and
views system parameters contained in the informa-
tion file while performing quantification.
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* When a PICT file is selected, following dialog will be displayed.

Original... : Converts to 8bit-PICT file without thinning out the pixel from original

image.

(If it is the 2byte-data, decreases gradation to the upper/lower limit

value on Range Scope.)

Window... : Converts conditions actually displayed on the window, such as color,

annotation, ROI, etc., to an 8bit-PICT file according to the pixel size on

the monitor.

(Only image data will be converted to the file and other information

will not be stored.)

* When a TIFF file is selected, following dialog will be displayed.

5.  Storing the File in Another Format

Window... : Converts conditions actually displayed on the window, such as

color, annotation, ROI, etc., to TIFF file (or palette color TIFF)

according to the pixel size on the monitor.

Original(8bit)... : Converts to 8bit-grey TIFF file without thinning out the pixel

size from original image. If it is the 2byte-data, decreases

gradation to the upper/lower limit-value on Range Scope.

Original(16bit)... : Converts 2byte-data to 16bit-grey TIFF file without thinning out

the pixel size from the original image. For 8bit data, this

function cannot be selected.
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Convenient Menu Functions to Learn
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1. File Menu Revert
This function rereads the original file for the currently open image
and opens it. However, this cannot be used if there is no image file.

Preference - Display
This file is for setting the image display conditions.

Preference - Distance
This function is used to set the unit of distance.

Paint Saturated Data to Red: Displays over-saturated pixels in red in all modes.
Always Show All Entry Area: Displays the ROI, lane or characters specified in each mode

also in other modes.
Show Annotation Information: Displays arrows and characters in Annotation mode.
Show Quant Area Number : Displays the number of quantification area specified in Quant

mode.
Show Profile Area Number: Displays the line or lane number specified in Profile mode.
Show Molecular Weight Contour Lines: Displays the contour lines in measurements of molecular

weight in Profile mode.
Show Distance Item Number: Displays the line number specified in Distance mode.

Set Positive Gray to All Images: Displays the image in gray when opening it the first.
Set Display Type to All Images: Selects gradation curve type when opening the image the

first. Use the pull-down menu.

Default: Uses the gradation curve referred
to in User Tips on page B-26.

Linear: Uses the linear tone curve.
Sigmoid: Uses the S tone curve.
Exponential: Uses the exponential tone curve.
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2. Image Menu Standard Mag
Restores images, Profiles, etc., enlarged with the Magnifying Glass
to their initial condition.

Sort
Sorts the measurement Nos. on the Result window in numerical
order.  (When group settings are made, this will be done for each
group.)

3. Analysis Menu

2.  Image Menu / 3.  Analysis Menu



G - 4

2001. Dec.   Version 1.0

Renumber
Assigns new measurement Nos. to compensate for missing Nos.

4.   Image Menu

4. Image Menu Change Color
Specify the order of colors on the pseudo-color display.
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Thank you for purchasing FUJIFILM Science Lab L Process Ver. 2.0 Before
using this software, please be aware of the following important items.

Regarding the use of Science Lab 2001 L Process software:
When you first started using this software, you agreed to the usage conditions
specified below, and Fuji Photo Film Co., Ltd. granted you a license to use the
Science Lab 2001 L Process software.
The ownership rights to the software belong to Fuji Photo Film Co., Ltd.   Part
of the ownership rights to this software belongs to ALTURA SOFTWARE, INC.
In keeping, this software is not something that is sold to you but something that
Fuji Photo Film Co., Ltd. grants you a license to use. The recording media is
yours, but the ownership rights to the software remain with Fuji Photo Film Co.,
Ltd.

LICENSE TERMS
1) You are granted the use of Science Lab 2001 L Process for a single

CPU or a single unit within multiple CPUs. Hence, in a computer
network environment, a separate Science Lab 2001 L Process license
will be required for each unit that will be using the software.

2) You are allowed to copy Science Lab 2001 L Process onto different
media for backup and program execution purposes.

USAGE LIMITATION
1) No copying, modification or transfer of Science Lab 2001 L Process

other than specified by the terms of the usage license is allowed.
2) No reverse compiling or reverse assembling of Science Lab 2001 L

Process done for the purpose of turning Science Lab 2001 L Process
into a readable format is allowed.

3) No lending or distribution of Science Lab 2001 L Process or a part
thereof for profit is allowed.

4) No derivative copyrighted product can be produced from Science Lab
2001 L Process, or modifications of it, or in conjunction with other
software.

NOTES
1) Reproduction of parts or all of the contents of this manual without

permission is prohibited.
2) The contents of this manual are subject to change without notice.
3) This manual has been prepared with utmost care. However, if you have

any questions or find errors, omissions, etc., please contact us.
4) We will not be liable for any effects incurred from the use of this device.

Copyright Reserved

<Reprint and/or reproduction of parts or whole of this manual is prohibited.>

Copyright© 1998-1999 by Fuji Photo Film Co., Ltd.

Apple logo is a registered trademark of Apple Computer, Inc. CanvasTM is a registered
trademark of Deneba Co., Ltd.  Excel is a registered trademark of Microsoft Co., Ltd.
Macintosh, Quick Time, and Geneva are registered trademarks of Apple Computer, Inc. Adobe
Photoshop is a registered trademark of Adobe Systems Co., Ltd. in the U.S.
All other company names and product names mentioned here in are the trademarks or
registered trademarks of their respective owners.

Read this first:



1 "Portions of this product are copyright ©1991-1997 Altura Software Inc. All

rights reserved."

2 "COMPANY'S LICENSOR (S)  MAKES NO WARRANTIES, EXPRESS OR

IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A

PARTICULAR PURPOSE, REGARDING THE SOFTWARE. COMPANY'S

LICENSOR (S)  DOES NOT WARRANT, GUARANTY, OR MAKE ANY
REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE

USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS,

ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE

SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF THE IMPLIED

WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU."

3 "IN NO EVENT WILL COMPANY'S LICENSOR (S), AND THEIR
DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS  (COLLECTIVELY

"COMPANY'S LICENSOR")  BE LIABLE TO YOU FOR ANY

CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS

INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE)

ARISING OUT OF THE USE OF, OR INABILITY TO USE , THE
SOFTWARE EVEN IF COMPANY'S LICENSOR HAS BEEN ADVISED OF

THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO

NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE

LIMITATIONS MAY NOT APPLY TO YOU."



This equipment cannot be taken to or used in a country
or area where power supply specifications differ from
those in the country or area where it was originally
installed.

This device is in compliance with the VCCI standards established by the conference on self-imposed control of noise
interference caused by information devices for the purpose of preventing interference in commercial and industrial
areas caused by Class 1 information devices (information devices to be used in commercial and industrial areas).
If this device is used in residential areas adjacent to them, it may cause radio disturbance.
This device must be handled correctly in accordance with this operation manual.

JAPAN

This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance
with the instructions manual, may cause interference to radio communications.
It has been tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of part
15 of FCC Rules, which are designed to provide reasonable protection against such interference when operated
in a commercial environment.
Operation of this equipment in a residential area is likely to cause interference in which case the user at his own
expense will be required to take whatever measures may be required to correct the interference.

United States of America

This digital apparatus does not exceed the Class A limits for radio noise emission from digital apparatus as set out
in the radio interference regulations of the Canadian Department of Communications.

“Le présent appareil numérique n’émet pas de brults radioélectriques cépassant les limites applicable aux appareils
numériques de la class A prescrites dans le Réglement sur le broulilage radioélectrique édicté par le ministére des
Communications du Canada.”

Canada
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1. L Process Ver.2.0 1 L Process Ver.2.0  (hereinafter referred to as "this software,") is for
analyzing and quantifying the image data input from the Image Reader
originally introduced to the market by Fuji Photo Film Co., Ltd. and for
image analysis and quantification of image data in RAW, PICT and TIFF
format.

2 The sample screens throughout this manual match the functions de-
scribed and the assumed selections and items that appear. In keeping,
when reading the manual.

3 For details on image reading through the IP Reader (BAS series and FDL-
5000), IP/Fluorescent Reader (FLA-2000 / 2000G, FLA-3000 / 3000G, FLA-
5000, FLA-8000) or Chemiluminescent/Fluorescent detecting camera
(LAS-1000 / LAS-1000plus / LAS-1000mini), refer to each operation
manual.

4 Image files created with versions earlier than this software (MacBAS V2.0 ~
V3.0, Image Gauge V.3.01 ~ V3.4) can be opened, analyzed and subjected
to other operations using this software. Image files created with this soft-
ware, however, cannot be used with previous versions (upwardly compat-
ible).

5 Use of this software has been confirmed for the following combinations of
systems connected to the IP Reader. If other combinations are used, the
software may become inoperable, depending on the SCSI.

Macintosh: PowerMac G4 733
Blue G3, G4, G3 MT266/ZIP, MT300/ZIP
* This software cannot be used on the 68K machine.

OS: Mac OS 9.21
SCSI card: 2906 (Adaptec)
CRT: 832x624 or more, 256 color or more

(we recommend the 32,000 color or more.)
LBP: LBP 350 (Canon)
Peripheral devices: Pictrography 3000(32MB/48MB), 3500,4000(120MB),

PSD400(96MB)
Application memory: Will differ depending on the image file size handled.

(Image file size + 10~20MB)

Reader Application Memory

BAS-5000 190MB or more

FLA-3000/3000G 95MB or more

BAS-2500
FLA-2000 90MB or more

FLA-2000G

BAS-1800II 75MB or more

BAS-1800 70MB or more

BAS-1500 36MB or more

BAS-1000 25MB or more

FDL-5000 45MB or more
LAS-1000 25MB or more

LAS-1000plus
FLA-5000 582MB or more

This manual has been written based on the assumption that the user has
experience using the Macintosh and is familiar with its basic operation and
displays.
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2. System Configuration <Supporting Peripheral Devices> (underlined units: available for old users)

IPR: BAS-5000, BAS-2500, BAS-1800, BAS-1800II,
BAS-1500, BAS-1000, FLA-3000/3000G,
FLA-2000/2000G, LAS-1000/1000plus,
FDL-5000, FLA-5000 (Either one)

Image buffer: IB-200

Pictro: Pictrography 3000 (32MB/48MB), Pictrography
3500 ,
Pictrography 4000 (120MB), PSD-400
(Either one)

LBP: LBP320 Pro (Canon), LBP750 (Canon),
LBP350 (Canon),
Laser Jet 6L(HP), Laser Jet 4LJ Pro(HP),
Laser Writer Select 610(Apple)
(Either one)
* 2MB memory should be expanded for the Canon's LBP and

HP's LBP.
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3. Overview

3. Overview / 4.1 Starting Up / 4.2 Opening an Image

System configuration, installation method, etc. for L Process Ver.2.0 are
the same as for those for Image Gauge Ver. 4.0. See pages A-4 in the
Operation Manual for Image Gauge Ver. 4.0.

4. Operation

4.1 Starting Up Click the L Process icon to open it, shown below.

L Process will start up along with the following opening screen.

L Process can handle the following kinds of images.
(1) ***.img of image data read with the FDL5000.
(2) Data transmitted from the Image Reader to the Macintosh.

(3) Image data saved in Image Gauge or MacBAS (Ver.2.0 or later) original
format.

4.2 Opening an Image

L Process is image processing software for active rewriting of images.
This software is for conducting FFT processing and differential, integral, and
other filter processing on images, as well as for performing intra-image
arithmetic processing, etc.
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(4) Image Gauge/MacBAS data saved in PICT, TIFF, or RAW format.

(8) Data from other applications saved in PICT (the majority), TIFF (8bit/
16bit-grey, palette color or RGB full-color), or RAW format.

To open an image, select Open or Import from the File menu on the menu bar.

Open Used when opening (1), (2), (3), (4),(5) and (7), above.
Import Used when opening (4), (6), and (8), above.

When Import is selected, a window like the following will open.

(6) Data from the L Process saved in PICT, TIFF, or RAW format.

(7) TIFF format data saved in Image Reader for LAS.

(5) Image data saved in L Process original format.
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Specify the file format in the above window.

When "RAW" is first selected as the file format, the following window will
open. Specify the width and height in terms of pixels, the depth (bit), and
header size (byte).

: Specifies that the top and bottom bytes of the word

should be switched when an image is taken up in Intel

format.

: Switches the values for Width and Height.

: Infers Width and Height using the original Depth and

Header Size values.
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Image window

4.3 Window When Image is Opened

When an image is opened, several windows will appear on it, like those
shown below.

4.3 Window When Image is
Opened

Image window Base window for image processing.
Tool window Window that contains the tools for selecting regions, etc.,

for magnification, scrolling, and other processing.
View window Window for confirming the entire image.
Gradation adjustment window Window for adjusting contrast, brightness, and gradation.
Info. window Window that displays the position of the tool on the

image and the size of the enclosed ROI.
Assist window Window for fine adjustment of the position and size of the

enclosed ROI.

Assist window

Gradation adjustment
window

Tool window

View window

Info.
Window
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4.4 Changing the Display

4.4.1 Changing the Display
Color

Select Color Type from the Image menu and then select the desired monitor
display command from the submenu that appears.

Negative Gray Displays in negative black and white (low-density regions are white;
high-density regions are black).

Positive Gray Displays in positive black and white (low-density regions are black;
high-density regions are white).

16 Color Displays in 16 pseudo-colors.
32 Color Displays in 32 pseudo-colors. (Brightness/Contrast is used to specify the

colors for low- and high-density regions.)
Red, Green, Blue Displays fluorescent colors in 32 gradations.

Linear Adjusts contrast with a linear curve.
Sigmoid Adjusts gradation with an S tone curve.
Exponential Adjusts gradation with a exponential curve.
Triangular Adjusts contrast with an serriform cyclic tone curve.
Rectangular Adjusts contrast with a rectangular waveform cyclic tone curve.
Free Hand Adjusts contrast with a free-hand tone curve.
Equalization Adjusts contrast with the tone curve automatically created by the software

in accordance with histogram frequency.

4.4.2 Adjusting Gradation 1 Select Scale Type from the Image menu and then select the desired
monitor display command from the submenu that appears.



8

2001. Dec.   Version 1.04.4.2 Adjusting Gradation

2 Linear

Place the cursor inside the gradation bar in the above window and drag it with
the (  ,  ,  ) adjusters.

Or, drag the brightness (B) and contrast (C) dials below the gradation bar.

Set values for each will be indicated in real-time.
Brightness and contrast can be adjuster even if the adjusted bar inside the
histogram is dragged.

Adjuster bar
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3 Sigmoid
Place the cursor inside the gradation bar and drag it with the adjusters (as
with Linear) or drag the Sigmoid dial below the gradation bar.

Set values will be indicated in real-time on the right side.

Brightness and contrast can be adjusted even if the adjuster bar inside the
histogram is dragged.

Adjuster bar

With Sigmoid, not only can adjustment be done with the left-right adjuster
bar but also with the up-and-down adjuster bar.

Adjuster bar
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4 Exponential

The value on the right of the curve (C) dial ( ) shows curvatures
parameters, which will change as the dial is dragged.

Place the cursor inside the gradation bar in the above window and drag it
with the (  ,  ,  ) adjusters.

You can slide the exponential curve position without changing curvature
of the exponential curve whether by placing the cursor in the gradation
bar on the window above to drag adjusters (  ,  ,  ) or by dragging
the upper limit bar appearing on the histogram.

Curve dial

By dragging the curve (C) dial, you can change curvature of the exponen-
tial curve.

Adjuster bar

Upper limit bar



11

2001. Dec.   Version 1.0 4.4.2 Adjusting Gradation

5 Triangular, Rectangular

Drag the phase (P) and frequency (F) dials.

Set values for each will be indicated in real-time.

6 Free Hand

Drag the  to create the tone curve.
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7 Equalization
As shown in the following figure, the tone curve will be automatically
drawn by the software.

User Tips
Image data and default display

Display formats when the image Window was opened and when the Trimming dialog was opened
will depend on the image data types.

• BAS series (BAS1000/1500/2000/2500/3000/5000) .......... (Exponential + Negative) display
• FLA series (FLA2000/FLA2000G/FLA3000/FLA3000G) .... (Exponential + Negative) display
• FDL5000 .............................................................................. (Linear + Positive) display
• LAS series (LAS1000/1000C/1000plus) ............................. (Linear + Negative) display
• Import files (Custom, TIFF, PICT) ....................................... (Linear + Positive) display
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4.4.3 Magnifying and
Reducing the Image
Display

The image display can be magnified and reduced using the following 2
methods.

(a) Select Mag. Level from the Image menu and then select the desired
magnification level from the submenu that appears.

The numbers given are ratios of the number of pixels on the monitor to
the number of pixels of the original image.
For example, for level 1:2 (monitor pixels: original image pixels), from 4
pixels of the original image, 1 pixel of the specific position is extracted
and the image thinned out (reduced) by making it equal 1 pixel on the
monitor.

(b) Selecting  the Magnifying Glass tool (  ) from the tool window and
clicking it in the image window to perform magnification and reduction.

Select the Magnifying Glass tool (  ). Bring it inside the image

window and it will change to (  ) for magnification.

Press the shift key and it will change to (  ) for reduction.

Magnifying Glass tool
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About the image window when the magnification level has been raised:
When the magnification level is raised, the entire image region will not be
able to fit within the image window.
At this time, green and red regions will appear as something like the
following in the view window shown below.

Green region: Indicates the region that can be displayed in the image
window.

Red region: Indicates the region that is currently displayed in the
image window.

Bring the cursor on the red frame, it will change to a   .  You can move
the red frame by dragging.
The image in the image window will be scrolled in realtime.

Bring the cursor on the green frame and the option key is pressed, it will
change to a  . You can move the green frame by dragging.
 When the green region is moved, the image in the image window will not
be scrolled in realtime. Also, it will take more time than moving a red
region.
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4.4.4 Enhancing Contrast 1 Select Rangescope... from the Image menu.

Rangescope is a function for enhancing the contrast of 14-bit and other
high-quantum image files by selecting the contrast portion you want to
display.
When the contrast level of the targeted image is concentrated in a narrow
range and Rangescope function is used on that narrow range to com-
press it, a sharper image can be obtained.
(Contrast can be adjusted by using the 8-bit gray scale on the com-
pressed range. When using Rangescope function in color mode, 16 or 32
colors will be available.)

Rangescope function just changes the monitor display and not
effects to the quantified values.
Rangescope function is not effective for images of 8 bits or under.

2 The following window will appear.

Overview box Box that displays the entire image.
Scopeview box Box that displays the image within the vicinity of the Viewscope frame

inside the Overview box.
Rangescope box Box that displays the intensity distribution of the image region from

either the Overview box or the Scopeview box, depending on which
has been selected.

Viewscope frame

Scopeview box

Rangescope box

Overview box
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3 Click inside the  and select Overview or Scopeview.
The selected one will change to .

4 To move the Viewscope frame, place the cursor inside the Overview box,

where it will change to   . Click the desired place and the Viewscope
frame will be moved to it.

5 There are two methods for compressing the range
(5-1) Value-input-based compression

(5-2) Compression by dragging the adjuster

(5-1) Click   in the Range Scope box
A dialog as shown below will appear.
Directly enter top/bottow values.

(5-2) Compression by dragging the adjuster
When the cursor is placed inside the Rangescope box, it will
change to an adjuster, . Drag the lower limit (red bar on the
left side inside the Rangescope box) and the upper limit (blue
bar on the right side inside the Rangescope box) to set them.
(If you leave the cursor between the lower limit and the upper
limit, the adjuster will change to, . At this point, you can drag
the lower and upper limit bars together keeping the same
distance.)

Click   to make fine adjustment.

6 After setting the upper and lower limits, click  and the image
window will change to the adjusted image.

Click the  button.The image will then be re-displayed

with newly set values.
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1 Using the Image Selector tool  on the tool window, set the region you
want to clip out.
(When no region is specified, a copy of the entire image will be made.)

4.4.5 Clipping Out a Region

3 When no region has been specified to be clipped out, the following
confirmation window will appear.

2 Select Clip Image from the Image menu.

Image Selector tool
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After Clip Image has been performed, the cursor will change to .

Click it and the image overlaid on the monitor can be moved up and
down.

4 The results of Clip Image will be displayed in a new window, as shown
below.
(Image processing can be performed on the clipped-out portion. When
the clipped-out portion is saved, image volume will correspond to the
area that was clipped out.)
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4.5 Measuring the Angle 1 Select the  Angle tool from the Tool window that follows image

display. (The cursor will change from   to .)

2 In this condition, click the starting point of the angle to be measured on

the image. With your finger released from the mouse button, move the

mouse to the ending point and then click the mouse again there.

Angle tool

3 Measurement results will be displayed in the Info window, shown below.

Location of starting point

Angle on the Y-axis side Angle on the X-axis side

Location of ending point

Current location of cursor
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Procedure for Modifying

the Unit in which Angle is

Displayed

Degree or Radian are the options available for selecting the unit in which

angles are displayed.

1 Double-click the  Angle Tool. (The following Angle Tool Options

dialog will be displayed.)

4.5  Measuring the Angle

2 Click the desired unit for displaying angles to select it.

Note: It is not possible to draw more than 2 angle measurement lines
at one time on one image. Drawing a new line will result in the
automatic deletion of the line drawn before it.
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4.6 Processing

4.6.1 Applying FFT 1 Double-click the Image Selector tool  on the tool window.
When FFT is applied, the number of pixels in the enclosed area must be
expressed as a power of 2.

2 The following Marquee Options window will appear.

4.6 Processing

3 In the above window, specify the method for enclosing the area.
Free(Normal) While the Image Selector tool is moved on the window,

the number of pixels will be shown as a power of 2.
At this time, refer to the number of pixels for width and
height specified in the Info. window.

Cursor position is viewed in terms of the standard
(0, 0 — top left of the screen) and displayed in terms of
the number of pixels from the left and the number from
the top. The starting point of the enclosing frame is also
viewed in terms of the same standard.

Fixed The number of pixels for width (W) and height (H) of the
Image Selector tool will be fixed.

2n The Image Selector tool moved on the screen will
automatically express the number of pixels as 2n.

Cursor position
Position of starting point of
enclosing frame

Number of pixels (width)
Number of pixels (height)
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4 Select FFT... from the Process menu.

5 The following FFT Option window will appear.

Select the desired window function.

The waveforms for each window function are shown below.

Window Function
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Select the data type.

QL (Quantum Level): Logarithm unit
cnt (count): Linear unit (shows the number of electrons)

However, for an image on which the following intra-image arithmetic
is done, the unit will change from cnt to AU.

A ¥ B: multiplication, A/B: division, sqrt(A): deriving the root,
log(A): taking the logarithm.

AU:  Aribitrary unit

Select whether to handle the image as a logarithm or not after FFT
has been applied.

To handle the image as a logarithm, click  to change it to  .
(The original data will remain as is.)

6 When  is clicked, FFT will be conducted.

4.6.1 Applying FFT



24

2001. Dec.   Version 1.0

4.6.2 Applying Rotational
Filter

The Rotational Filter is used to eliminate FFT image background.

1 After creating an FFT image, select Filter... from the Process menu and

then select Rotational... from the submenu that appears.

2 The following Rotational Options window will appear.

Enter the threshold value.

3 Clicking  will leave pixels that have values larger than the

threshold as they are and set values smaller than the threshold to 0.

4.6.2 Applying Rotational Filter
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1 Using the Mask tools in the tool window, set the frequency area for
applying Inverse-FFT to an image to which FFT has been applied.

Double-click the Circle Mask tool. The following options window will open.(a) Circle Mask tool

   

4.6.3 Applying Inverse-FFT

Set the circle radius in terms of pixels. Even after this has been done, the
size of the circle can still be changed as desired on the screen.

Decide whether the selected region (effective area) will be inside the circle
or outside it.

To resize, drag any of the 4 green points.

4.6.3 Applying Inverse-FFT Inverse-FFT will be applied to an image to which FFT has been applied.
After FFT has been applied, all the tools in the tool window will be available
for use.

Circle Mask tool

Twin Mask tool

Array Mask tool Freehand Mask tool

Lane Mask tool

Donut Mask tool
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Double-click the Donut Mask tool. The following options window will
open.

(b) Donut Mask tool

   

4.6.3 Applying Inverse-FFT

Set the radius of the circles inside and outside the donut in terms of pixels.
Even after the radii have been set, the size of the circles can still be changed
as desired on the screen.

Decide whether the selected region (effective area) will be inside the two
circles of the donut or outside them.

To resize, drag any of the 4 green points.
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Double-click the Twin Mask tool. The following options window will open.(c) Twin Mask tool

   

4.6.3 Applying Inverse-FFT

Decide whether the selected region (effective area) will be inside the twin
circles or outside them.

Set the radius of the circles in terms of pixels. The radius can be modified
even after it has been set by using this window. Even after the position of
the circles has been set, it can be changed as desired on the screen.

To resize, drag either of the 2 green points.
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(d) Lane Mask tool

   

4.6.3 Applying Inverse-FFT

Double-click the Lane Mask tool. The following options window will open.

Set the lane width in terms of the number of pixels. Even after the lane
width has been set, it can be modified in this window. Lane length and
direction can be changed as desired on screen after settings have been
made.

Decide whether the selected region (effective area) will be inside the lanes
or outside them.

To adjust lane width and direction, drag any of the 4 green points.
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(e) Freehand Mask tool

   

3 To set the Inside and Outside options for the Effective Area, double-

click  Freehand Mask, to call up the following Freehand Mask

Options dialog.

1 Click  on the toolbox to select Freehand Mask.

2 On the FFT image, drag from the starting point to the ending point.

(If the starting point and ending point are not the same point, the

software will automatically connect them.)
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Double-click the Array Mask tool. The following options window will open.(f) Array Mask lane

   

4.6.3 Applying Inverse-FFT

Select an odd number for the number of circles in 2 directions.
On the screen, this will be shown as the first direction set  (multiply) the
next direction set.

Even after the circle radius has been set, it can be modified through this
window.
After the direction and array width have been set, they can be changed as
desired on the screen.
Decide whether the selected region (effective area) will be inside the
circles or outside.

Even after the number of circles has been set, it can be modified through this
window.
Set the number of pixels for the radius of the circles.

To modify direction or array width, drag either of the 2 green vectors.



31

2001. Dec.   Version 1.0

2 Select Inverse FFT... from the Process menu.

3 The following Inverse-FFT Options dialog will open.

In the above dialog, specify whether to display the Inverse-FFT image inside
the image prior to applying FFT or to display it in the new window.

4 Click  button. Inverse-FFT will be conducted.

4.6.3 Applying Inverse-FFT / 4.6.4 Saving the FFT Image

4.6.4 Saving the FFT Image When the check button is clicked for  in the following

window -- which is displayed when Inverse FFT is being used -- and

leaving it selected, Inverse FFT will be performed with the FFT image saved

as it is.

Note: This will not be possible if there is no available memory for
saving the FFT image.
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4.6.5 Applying Filter

4.6.5 Applying Filter

Eleven kinds of filters can be used.

Low-pass filters (low-frequency pass filters) Æ Noise elimination and smooth-
ing

- Averaging
- Median

High-pass filters (high-frequency pass filters) Æ Line and edge detection
and image sharpness

- Gradient
- Roberts
- Sobel
- Laplacian
- Prewitt
- Marr-Hildreth
- Sharp

Enhancing changes in the original image (automatic processing of the
operation between images)

- Unsharpmask

Using a filter kernel that has been created as desired.
- Custom
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3 In the above window, select the method for enclosing the area with a
frame.
Free(Normal) While the Image Selector tool is moved on the screen,

the number of pixels will be expressed arbitrarily.
At this time, refer to the number of pixels for width and
height specified in the Info. window.

4.6.5 Applying Filter

Fixed The number of pixels for width (W) and height (H) of
the Image Selector tool will be fixed.

2n The Image Selector tool moved on the screen will
automatically express the number of pixels as 2n.

4 Using the following procedure, conduct filter processing.

Cursor position
Position of starting point of
enclosing frame

Number of pixels (width)
Number of pixels (height)

1 Double-click the Image Selector tool  in the tool window.

2 The following Marquee Options window will appear.
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Specify kernel size using odd numbers.

When others... is selected, the following window will open.

Set kernel size using odd numbers in the horizontal and vertical directions.
After setting, click the  button.
It is possible to set the size to up to 1/8th of the image domain that was
selected.

(a) Applying averaging Using the set kernel size (pixel ¥ pixel), the average value is sought and
that value becomes the value for the point of focus.
This processing is done for the specified area.
Select Filter from the Process menu and then select Averaging from the
submenu that appears.
The following Averaging Options window will open.
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Select the averaging type.

Simple Averaging will be done after assigning a coefficient of 1
to each pixel that makes up the kernel (simple
averaging).

Gaussian Averaging will be done after a weighted coefficient
based on regular distribution is applied to each pixel in
the kernel.

Select the window in which to display the image after processing.

Current Window Displays image in the window it was displayed in
prior to processing.

New Window Displays image in a new window.

Click the  button and filtering will be performed.
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In the same way as for averaging, set kernel size and select the window that
the image should be displayed in after processing and click the 
button. Filtering will then be performed.

(c) Applying Gradient Move in the x and y directions the kernels that have the following coeffi-
cients.
Then, take the geometrical mean and conduct processing.

4.6.5 Applying Filter

Select Filter from the Process menu and then select Gradient from the
submenu that appears.
The following Gradient Options window will open.

0 0 0
0 1 -1
0 0 0

0 0 0
0 1 0
0 -1 0

X Y

Arrange linearly the intensity of each pixel in the specified kernel size
(pixel x pixel) and make the center value the value of the point of focus.
This processing is done on the specified area.
Select Filter from the Process menu and then select Median from the
submenu that appears.
The following Median Options window will open.

(b) Applying Median
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Set the amplitude. The value input for the calculated value from filtering can
be applied.

4.6.5 Applying Filter

Select an offset value. The value input for the calculated value from filtering
can be applied.

Select the effect type.

Emphasize The portion that has changed will be emphasized (Edge
emphasis).

Detect Only the portion that has changed will be displayed
(Edge emphasis).

Select the window the image should be displayed in after processing.

Current Window Displays image in the window it was displayed in
prior to processing.

New Window Displays image in a new window.

When the  button is clicked, Filtering will be performed.
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Move in the x and y directions the kernels that have the following coeffi-
cients.
Then, take the geometrical mean and conduct processing.

(d) Applying Roberts

Select Filter from the Process menu and then select Roberts from the
submenu that appears.
The following Roberts Options window will appear.

4.6.5 Applying Filter

As for Gradient, select the amplitude, offset value, effect type, and appropri-
ate window; then, click the  button and filtering will be performed.

0 0 0
0 1 0
0 0 -1

0 0 0
0 1 1
0 -1 0

X Y
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Move in the x and y directions the kernels that have the following coeffi-
cients.
Then, take the geometrical mean and conduct processing.

(e) Applying Sobel

Select Filter from the Process menu and then select Sobel from the
submenu that appears.
The following Sobel Options window will open.

4.6.5 Applying Filter

As for Gradient, select the amplitude, offset value, effect type, and appropri-
ate window; then, click the  button and filtering will be performed.

-1 0 1
-2 0 2
-1 0 1

-1 -2 -1
0 0 0
1 2 1

X Y
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Use one of the 3 types of kernels with the coefficients shown below.(f) Applying Laplacian

Select Filter from the Process menu and then select Laplacian from the
submenu that appears.
The following Laplacian Options window will open.

4.6.5 Applying Filter

Select the operator type.

As for Gradient, select the amplitude, offset value, effect type, and appropri-
ate window; then, click the  button and filtering will be performed.

0 -1 0
-1 4 -1
0 -1 0

-1 -1 -1
-1 8 -1
-1 -1 -1

Type1 Type2
1 -2 1
-2 4 -2
1 -2 1

Type3
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Conduct processing by using the 8 types of kernels with the following
coefficients and the template matching method.

(g) Applying Prewitt

Select Filter from the Process menu and then select Prewitt from the
submenu that appears.
The following Prewitt Options window will open.

4.6.5 Applying Filter

As for Gradient, select the amplitude, offset value, effect type, and appropri-
ate window; then, click the  button and filtering will be performed.

1 1 1
1 -2 1
-1 -1 -1

1 1 1
1 -2 -1
1 -1 -1

(1) (2)
1 1 -1
1 -2 -1
1 1 -1

(3)
1 -1 -1
1 -2 -1
1 1 1

(4)

-1 -1 -1
1 -2 1
1 1 1

-1 -1 1
-1 -2 1
1 1 1

(5) (6)
-1 1 1
-1 -2 1
-1 1 1

(7)
1 1 1
-1 -2 1
-1 -1 1

(8)
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With the Marr-Hildreth option, processing will be done with kernels for
which the Laplacian option to has been applied to Gaussian distribution.
These coefficients will derive various values based on the number of pixels
in the kernels.
The following formula can be used to derive the original coefficient.

(h) Applying
Marr-Hildreth

4.6.5 Applying Filter

Select Filter from the Process menu and then select Marr-Hildreth from the
submenu that appears. The following Marr-Hildreth Options window will
open.

 Select the kernel size, amplitude, offset value, and
appropriate window; then, click the  button and filtering will be
performed.
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With the Sharp Filter option, changes in the original image are enhanced by
automatically subtracting unsharp image from the original image.

Select Filter from the Process menu and then select Sharp from the
submenu that appears.
The following Sharp Options window will open.

(i) Applying Sharp Filter

Select the kernel size, amplitude, offset value and appropriate window, then
click the  button and sharp filter will be applied.

4.6.5 Applying Filter
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With the Unsharpmask option, changes in the original image are enhanced
through analysis of the original image +a (original image - unsharp image).

* a : Amplitude in the Unsharpmask Options window below.

Select Filter from the Process menu and then select Unsharpmask from the
submenu that appears.
The following Unsharpmask Options window will open.

(j) Applying
Unsharpmasking

4.6.5 Applying Filter

Select the kernel size, amplitude and appropriate windows, then click the
 button and unsharp masking will be performed.
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With Custom, a kernel with coefficients set arbitrarily by the operator is used
for processing.
Select Filter from the Process menu and then select Custom from the
submenu that appears.
The following Custom Matrix Kernels window will open.

(k) Applying Custom

4.6.5 Applying Filter

As for averaging, set the kernel size.
Also, set the scale value.

After processing, the value of the point of focus will be divided by the scale
value.
Set the offset value, select the window, and input the coefficients in the grid
of the kernel.

Click the  button and filtering will be performed with the created

kernels.

Click and the kernel will be saved (in text format).

Click and it will be possible to call up the kernel.
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4.6.6 Inverting the Image
Data

Pixel values composed the image can be converted(inverted).
For the FFT images and the Contour plot images, this function is not
available. When the image data pixel is 16384 gray level (14 bit), each pixel
will be converted as follows.

Before converting After converting
0 -> 16384
1 -> 16383

.

.

.
16383 -> 1
16384 -> 0

1 Open the target image.
Specify the target region.  (If you have not specified any region, all the
region will be inverted.)

2 Select Invert... from the Process menu.

The following Invert Options window will open.
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3 Select the window in which to dispiay the image after processing.

4 Click  button to invert the image (region).

When white/black spots appear on the read image causing the detector's
pixel failure, you can remove (filter) them using this function.

1 Open the target image and specify the target region.  (If you have not
specified any region, all the region will be filtered.)

2 Select Hot/Cold Spot Filter... from Process menu.

4.6.7 Filtering the Hot /
Cold Spot

The following Hot/Cold Spot Filter window will open.
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3 Input the filtering constant.

If the spots is in higher level (Hot spot), first the difference (a) between
the target pixel and the maximum pixel around the target pixel is ob-
tained, then (a) and the difference between maximum pixel and mini-
mum pixel around the targer pixel will be compared.
If "10" is input as a constant, the target pixels (spots) will be removed
when (a)>(b)10 is satisfied.

4 Select the window in which to display the image after processing.

5 Click  button to execute this function.

Example of Effection
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1 Using the Image Selector tool in the tool window, set the area to be
rotated.
(If no area is set, the entire image will be rotated.)

2 Select Rotate... from the Process menu.

4.6.8 Rotate Function

4.6.8 Rotate Function

Set the angle of rotation.

The following Rotate Options window will open.

Set the display magnification to follow rotation.
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Set the direction of rotation.

CW Rotation will be clockwise.
CCW Rotation will be counterclockwise.

Select the image interpolation method to follow rotation.
(Interpolation will be done on the pixel of the non-lattice point following
rotation.)

Nearest neighbor : The density of the lattice point for the uv coordi-
nates closest to the non-lattice point (u0, v0) will be
set as the value for (u0, v0).

Bi-linear : Using the densities of 4 lattice points around the non-lattice
point (u0, v0), the density for (u0, v0) is interpolated linearly.

f(u0, v0)=f(u',v')(1-a)(1-B) +f(u'+1,v' )a(1-B) +f(u',v'+1)(1-a)B
+f(u'+1,v'+1)aB

u'=(u0), v'=(v0), a=u0-(u0),  B=v0-(v0),
(w) expresses the maximum integer that does not exceed w.

Bi-cubic : Using the densities of 16 lattice points around (u0, v0), cubic
interpolation is done.

Here (uk,vl) is a lattice point around (u0 , v0) and interpolative
coefficient c(x) is defined linearly.

Function c(x) is piecewise three-dimension polynomial
approximation of function sinx/x that is revealed with the
sampling theorem for continuous signals.
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Select the window the image should be displayed in after processing.
Also, activate (check) " ."

4.6.8 Rotate Function

3  Click the                 button to conduct rotation.

When Clip... has not been
checked.

When Clip... has been
checked.
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The result of the last angle measured when image rotation functions were

used will be set as the default value for the rotation angle for image

rotation.

The smallest result of angle measurement, which in the above example is the angle
that will serve as the X axis, will become the default value for "Angle" in the
Rotate Options dialog.

From the above example, 40.696 degree will
be set as the default for "Angle."

4.6.8 Rotate Function
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4.6.9 Flip Function 1 Using the Image Selector tool in the tool window, define the area to be
flipped.
(If no region is defined, the entire area will be flipped.)

2 Select Flip... from the Process menu.

4.6.9 Flip Function

The following Flip Options window will open.
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Select the direction of flipping.

4.6.9 Flip Function

Horizontal Area will be flipped horizontally.
Vertical Area will be flipped vertically.

Select the window the image should be displayed in after processing.

3 Click the   button and flipping will be done.
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4.6.10 Joint Function 1 Open the entire image that you want to attach.

* Only image of the same size and density resolution can be attached.

2 Select Joint... from the Process menu.

4.6.10 Joint Function

Select the direction in which you want to attach the image.

Horizontal Image will be attached horizontally.
Vertical Image will be attached vertically.

The following Joint Options window will open.
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Select the image that you want to joint.

Selection can be made from the pulldown menu.

3 Click the  button to joint the image.

4.6.10 Joint Function
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4.6.11 Modifying the Image
Aspect Ratio

This function is used to modify an image's vertical-to-horizontal ratio.
It is effective for correcting distortion and the like in images obtained from
external detection devices.

1 Select the image domain for processing and then select Aspect Ratio...
from the Process menu. The following Aspect Ratio Options dialog will
be displayed.

4.6.11 Modifying the Image Aspect Ratio
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Original Size: Original size of the select domain (unit: pixels).

Converted Size: Input the desired post-modification size (unit: pixel).

Interpolation: Select the type of interpolation desired at time of

modification.

Nearest Neighbor: Sets the density for the lattice point of the uv

coordinates that are closest to non-lattice point

(u
0
, v

0
) as the value for (u

0
, v

0
).

Bi-Linear: Using the densities of the 4 lattice points

surrounding non-lattice point (u
0
, v

0
), the density

of (u
0
, v

0
) is interpolated via the following formula.

f(u
0
,v

0
)=f(u',v')(1–a)(1–b)+f(u'+1,v')a(1–b)

+f(u',v'+1)(1–a)b+f(u'+1,v'+1)ab

u'=(u
0
), v'=(v

0
), a=u

0
–(u

0
),  b=v

0
–(v

0
),

(w) expresses the maximum integer, which will

not exceed w.

Bi-Cubic : Using the densities of the 16 lattice points

surrounding (u
0
, v

0
), 3-dimensional interpolation

is done.

Here, (uk, v1) is a lattice point surrounding (u0,v0).

Interpolation coefficient c (x) is defined with the

following formula.

Function c (x) is a divided 3-dimensional

polynomial expression approximation of function

sinx/x, which appears in continuous signal

sample processing.

2 Click to implement.
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4.6.12 Using Arithmetic 1 Open the entire image you want to use arithmetic on.

* Intra-image arithmetic can only be performed an images of the same size and
density resolution.

2 Select Arithmetic... from the Process menu.

4.6.12 Using Arithmetic

The following Arithmetic Options window will open.

Select the desired type of arithmetic.

Offset input range

Multiplication coefficient
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A+B: Addition, A-B: Subtraction, AxB: Multiplication, A/B: Division
AxA/B: Multiplication and division done at one time
A+const: Add a constant, A-const: Subtract a constant,
Axconst: Multiply by a constant, A/const: Divide by a constant,
sqrt(A) x const: Take the root and multiply by a constant,
log(A) x const: Take the logarithm and multiply by a constant..

Input the offset value (the pixel (QL) value to be added to image data after
processing).

Input the amplitude for the image and image data on which arithmetic was
done.

The image to undergo arithmetic can be selected from the pulldown menu.

When performing arithmetic that involves a constant, input a value for the
constant.
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Select the data type to be used in the arithmetic.

QL : Arithmetic done with QL (pixel) value.
AU : Arithmetic done with linear value.

* The AU portion will display the unit of the image being handled

.

Select whether to align the position between images or not. If the position
alignment function is selected, specify either of the following options.

None : Position alignment not performed.
Manual : Manually performed position alignment by checking

overlapped images on the mirror.
Spot mark : Semi-automatic position alignment using the Markspot tool.
Line mark : Semi-automatic position alignment using the Markline tool.

Select when using the function for aligning the position between two images
on which the Markspot tool and the Markline tool have been used.

Select the window to show the results of arithmetic in.

New Window Results will be displayed in a new window.
Image A Window Results will be displayed in one of the image

windows (A) used in the arithmetic.
Image B Window Results will be displayed in one of the image

windows (B) used in the arithmetic.

3 Click the  button to perform arithmetic.
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4.6.13 Manually Aligning the
Image Position

With the function, image position can be manually aligned viewing an image
overlapped with another.

1 Open the image you want to use arithmetic on.

*  The "image" above implies the image other than Contour Plot on FFT images.

2 Select Arithmetic... from the Process menu.

3 Specify several items in the Arithmetic Options dialog and select Manual
from the Position Matching Type.

4 Clicking the  button will display the matching dialog shown on
next page.

4.6.13 Manually Aligning the Image Position
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On this dialog, Image A is displayed overlapped with Image B.

Clicking the  button will perform arithmetic.

Image B that overlaps Image A can be moved by dragging. If angle

adjustment is required, enter the rotation angle and clock  and  .

Overlapping Image B will then rotate.

4 If the  button is clicked, the image will be displayed enlarged as
follows.

Contrast adjustment of Image A

Contrast adjustment of Image B

Overall rotation angle of Image B

Enter rotaiton angle of Imge B.

Counterclockwise rotation

Clockwise rotation

Detailed display

Execution of arithmetic

Cancel

Whole image display

Execxution of arithmetic

Cancel

The portion within this circle
is displayed enlarged, which
can be moved by dragging.

Used to move overlapping
Image B. Image B can be
moved also by image dragging.

Clicking the  button will perform arithmetic.

Image A overlapped
with Image B

Image A overlapped
with Image B

4.6.13 Manually Aligning the Image Position
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4.6.14 Semi-automatically
Aligning the Image
Position

This function is for semi-automatic overlapping of the space between two

images (of the same sample) for intra-image arithmetic.  The Markspot tool

and Markline tool can be used.

Markspot tool : Aligns the position between two images.

Markline tool: Aligns the position/angle between two images.

1 Open the images for intra-image calculation.

* This means to open any but a Contour Plot or FFT image.

2 Using the Markspot tool, specify the portion that will serve as the

standard for image overlapping.

1) Double-click the Markspot tool on the Tool window. The following

dialog will be displayed.

4.6.14 Semi-automatically Aligning the Image Position

(a) Markspot tool

Markspot tool
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Here, select Markspot Area Size.

Markspot Area Size:  At time of overlapping, a rectangle is created

using Markspot  as the center, and intra-image

overlapping is done via relative calculation from within that

area. Markspot Area Size indicates the size of the rectangle

used at that time.

Small: Creates a rectangle with 200 pixels on 1 side.

Medium: Creates a rectangle with 400 pixels on 1 side.

Large: Creates a rectangle with 600 pixels on 1 side.

2) After Mark Spot Area Size has been selected, place the Markspot on

the portion that will serve as the standard for overlapping the area

between two images (that is, on a portion that is common to both

images).

Image A Image B

Place the Markspot on the portion that
will serve as the standard for overlapping
the area between two images.
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3) For the image that corresponds to the head of the left side of the

image arithmetic formula (for A - B, it would be image A, for

example), use the Enclosure tool from the Tool window to specify

the area between the images that you wish to calculate.

Enclosure tool

Specifying the area to be calculated
with the Enclosure tool

* The Markspot does not need to be within the area to be calculated.
* For the image that corresponds to the head of the right side of the image

arithmetic formula (for A - B, it would be image B, for example), after
relative calculation of the space between two images, the calculated area
will be automatically set.

* If no area has been specified, the entire area will be subjected to
calculation.
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4) Select Arithmetic.... from the Process menu.

4.6.14 Semi-automatically Aligning the Image Position

The following Arithmetic Options dialog will be displayed.

Position Matching Type:

Select Spot mark.

Auto Adjust:

On: Performs position alignment using relative calculation.

Off: Performs position alignment between two images using

Markspot position and without performing relative calculation.

5) Click  here to perform intra-image arithmetic using

position alignment with the Markspot tool.
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1 Open the images for intra-image calculation.

* The images referred to here are those other than Contour Plot and FFT images.

2 Using the Markline tool, set a portion that will serve as the standard for

total-image overlapping.

1) Double-click the Markline tool in the Tool window.  The following

dialog will be displayed.

(b) Markline tool

4.6.14 Semi-automatically Aligning the Image Position

Markline tool

Select Markline Area Size here.

Markline Area Size: At time of overlapping, a rectangle is created

focusing on Markline's starting point and ending point .

In that region, with relative calculation, intra-image overlapping

is done. Sizes of the rectangles created are defined as follows:

Small: Creates a rectangle with 200 pixels on one side.

Medium: Creates a rectangle with 400 pixels on one side.

Large: Creates a rectangle with 600 pixels on one side.
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Image A Image B

2) After selecting Markline Area Size, create the Markline using 2 points

(Markline's starting point and ending point) from the portion that

serves as the standard for 2-image overlapping (the area between the

two images that is jointly shared).

Place the Markspot on the portion
that serves as the standard for
2-image overlapping.
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3) For the image the corresponds to the head of the left side of the

image arithmetic formula (for A-B, it would be image A, for example),

use the Enclosure tool from the Tool window to specify the area

between images that you wish to calculate.

Enclosure tool

* The Markline does not need to be within the area calculated.
* For the image that corresponds to the head of the right side of the

image arithmetic formula (for A-B, it would be image B, for
example), after relative calculation of the space between two
images, the calculated area will be automatically set.

* If no area has been specified, the entire area will be subjected to
calculation.
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4) Select Arithmetic... from the Process menu.

The following Arithmetic Options dialog will be displayed.

Position Matching Type:

Select Line mark.

Auto Adjust:

On: Performs position/angle alignment using relative

calculation.

Off: Performs position/angle alignment between two images

using Markline position as the standard and without

performing relative calculation.

5) Click  here to perform intra-image arithmetic after

position/angle alignment using the Markline tool.
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4.6.15 Displaying Calculation
Overflow/Underflow
During Image Processing

When there is pixel overflow or underflow for each type of filter or

intra-image arithmetic result, a dialog like the following will be displayed.

4.6.15 Displaying Calculation Overflow/Underflow During Image Processing



73

2001. Dec.   Version 1.0

4.6.16 Displaying the Compsed
Fluorescent Image

1 Open the image you want to display composed.
Display each image in fluorescent colors.

2 Select Compose from the Process menu.

4.6.16 Displaying the Composed Fluorescent Image

3 In the Compose Options dialog, select the image you want to display
composed.

*  Image A and B must be displayed in different fluorescent colors.

4 Clicking the  button will display the Compose dialog shown on
next page.
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Contrast adjustment of Image A

Contrast adjustment of Image B

Overall rotation angle of Image B

Enter rotaiton angle of Imge B.

Counterclockwise rotation

Clockwise rotation

Detailed display

Execution of image
composition

Cancel

Execxution of image
composition

Cancel

The portion within this circle
is displayed enlarged, which
can be moved by dragging.

Used to move overlapping
Image B. Image B can be
moved also by image dragging.

Image A overlapped
with Image B

Image A overlapped
with Image B

On this dialog, Image A is displayed overlapped with Image B.

Clicking the  button will perform image composition.

Image B that overlaps Image A can be moved by dragging. If angle

adjustment is required, enter the rotation angle and clock  and  .

Overlapping Image B will then rotate.

4 If the  button is clicked, the image will be displayed enlarged as
follows.

Detailed display

Clicking the  button will perform image composition.

* Images that have been subjected to image composition cannot be stored.
Any image processing is also not possible. Image export to the TIFF file is possible.

PICT file: Export at display resolution
TIFF file: Export at display resolution
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4.6.17 Displaying the Contour
Line

1 Using the Image Selector tool in the tool window, set the area for which
you want to display the contour line.

2 Select Contour Plot... from the Process menu.

4.6.17 Displaying the Contour Line

The following Contour Plot Options window will be displayed.
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Select the unit in which the contour line should be displayed.

QL (Quantum Level) Logarithm unit

cnt (count) Linear unit (shows the number of electrons).

However, for an image on which the following intra-image arithmetic is

done, the unit will change from cnt to AU.

AxB :multiplication, A/B :division, sprt(A) :deribing the root,

log(A) :taking the logarithm.

Set the number of lines for the contour line, up to a maximum of 16.

The number of  lines can be set from the pulldown menu.

At first, the triangle marker will overlap the setting for number of lines, as

shown below.
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Drag the triangle marker to the desired position.
At this time, the value for the triangle marker will be shown within the Value
box in terms of the specified unit (here, QL).

After setting the maximum and minimum values for the contour line, click

the   button. The space between the maximum and minimum
values will be divided uniformly with the selected number of contour lines.
(In this example, 4 contour lines were used.)

If an arbitrary value is input for Value, the triangle marker will move to the
position of the input value.

Select the display color for the contour line.

B/W Black and white display.
Color Color display.

3 Click the  button and the contour line will be made.

4.6.17 Displaying the Contour Line
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4.7 Displaying Multiple
Images

When multiple images have been opened, the following 2 display methods
can be used.
(a) Cascade Images are displayed in staggered form.
(b) Tile Images are displayed lined up like tiles.

1 Select Cascade from the Window menu.

4.7 Displaying Multiple Images

(a) Cascade

The display will be something like the following.
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1 Select Tile from the Window menu.(b) Tile

The display will be something like the following.

4.7 Displaying Multiple Images
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4.8 Saving The following 3 methods can be used for saving.
(a) Save The overwritten or already processed (involving changes in

the pixel value) image will be newly saved.
(b) Save as Saves image data in another name.
(c) Export A portion of the image is clipped out and saved in another

format.

4.8 Saving

(a) Save

Specify the destination for saving in the open dialog.

1 Select Save... from the File menu.

(b) Save as

Input the fillename and specify the destination for saving in the open

dialog.

1 Select Save as... from the File menu.
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2 The following dialog will be displayed.  Set the Export destination and

then click .

(c) Export 1 Select Export from the File menu and specify file type from the submenu
of the File menu.

PICT... : Exports an image to PICT file with the number of pixels on the monitor.

TIFF... : When a TIFF file is selected, the following dialog will appear.

Raw... : Exports an image to raw image.

Window... : Converts conditions actually displayed on the Window to the
TIFF file (palette color TIFF) according to pixel size on the
monitor.

Original(8bit)... : Convers to 8bit-grey TIFF file without thinning out the pixel
size from original image. If it is the 2byte-data, decreases
gradation to the upper/lower limit-value on Range Scope.

Original(16bit)... : Converts 2byte-data to 16bit-grey TIFF file without thinning out
the pixel size from the original image. For 8bit data, this
function cannot be selected.
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3 When exporting an image of density resolution of 8 bits or more in RAW

format, the following Raw Export Options dialog will be displayed.

4 Click   or and

then click  to implement.

(The 8-bit depth will be used for the histogram domain selected with

Rangescope.)

This value varies
depending on
the image.

4.8 Saving
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4.9 Undoing Processing This function can be used to undo the previous process.

1 Select Undo from the Edit menu.

4.9 Undoing Processing

The previous process will be undone.

* Undo can only be used to undo the previous process when no other method is
available.

For example, in magnification processing, Undo cannot be used because
reduction processing can be used to fulfill the same function.

To reverse all image processing and restore the image to its original state,
select Revert from the File menu.

The original image will be restored.
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4.10 Viewing Image
Information

1 Select File Info... from the File menu.

4.10 Viewing Image Information

The following File Information screen will open.

To  close this window, click inside it.
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4.11 Printing

4.11.1 Printing Image on
Laser Beam Printer

4.11 Printing

2 Select  Page Setup... from the File menu and select paper setteings.

3 Select Print... from the File menu to print.

1   Activate the window of the image that you wish to print.
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4.11.2 Easily Printing Images
Out on Pictrography
3000, 3500, 4000 or
PSD400

1 Activate the window of the image that you wish to print.

2 Select Print Pictro... from the File menu.

3 The following dialog will be displayed.

Pictrography 4000 or PSD400 Pictrography 3000, Pictrography 3500
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Window: Displays the name shown in the window header of the image

targeted for printing.

This name will be printed out as additional information on the

bottom left of the printing paper, in black.

Printing position will be as follows. (Character size is fixed.)

* The arrows indicate the direction of the top of the image on CRT
display.

Image Size: Displays the size of the image targeted for printing.

Print Type:
1:1 pixel (Display Mag.)

Prints images using the image display magnifiation ratio.
* The size will change depending on the image display

magnification ratio effective at the time (which will be
displayed in parentheses at the end of the image name).

1 : 1  -> Prints with 1 pixel of image data corresponding to 1
pixel on Pictrography.

1 : 2  -> Prints with 2x2 pixels of image data corresponding
to 1 pixel on Pictrography.

2 : 1  -> Prints with 1 pixel of image data corresponding to
2x2 pixels on Pictrography.

* The size of the image to be printed out will differ with the
image display magnification ratio. Thus, select the image
magnification ratio prior to printing.

Example: When display magnification ratio of 1:1 and paper
size "A4" are selected for an image of 3000x3760
pixels, the image will be printed out so that it
takes up nearly the entire surface of the paper.

1:1 image
Prints free-size images. The width and height can be finely
adjusted using the Adjust Width/Adjust Height option.

Paper Size: Indicates the size of paper used for printing out the image.
* The paper size differs depending on the printer that is connected.  In the
case of PG4000 or PSD400, the paper size is automatically determined by
the width of the paper being loaded.
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* When the size of the image targeted for printing is larger than the size of the
paper, a warning dialog like the following will be displayed, and only the area of
the image that will fit inside the paper from the center out will be printed.

4 After selecting Paper Size, click .

5 The following dialog will be displayed and the sending of data to

Pictrography will begin.
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4.12 Starting Up Other Soft-
ware

1 Select New Entry from the Application menu and select the software
you want to enter.

After you have done so, you can start up other software from the
Application menu, as shown next.

When the Application menu is used to start up other software, the
following Launch Options window will open.

Release from list Releases the currently entered software from the list.
Launch Only Starts up the entered software without saving the current image.

**Used when None (no saving) is selected under Save File Type.
  When other than None is selected under Save File Type:

   will change to 

Save & Launch Saves the current image (file format used for saving is selected from the
window) and starts up the entered software.

When  Quit L Process to Launch is selected, the entered software will be
started up after L Process is quit.

4.12  Starting Up Other Software
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